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Important Precautions and Safety Information

 

When using this product, these basic safety precautions should always be followed 
to reduce risk of fire, electric shock, and injury to persons:

 

1

 

Read and understand all instructions.

 

2

 

Use common sense whenever operating electrical appliances.

 

3

 

Follow all warnings and instructions marked on the product and in the literature 
accompanying the product.

 

4

 

If an operating instruction appears to conflict with safety information, heed the 
safety information. You may have misunderstood the operating instruction. If 
you cannot resolve the conflict, contact your sales or service representative for 
assistance.

 

5

 

Unplug the product from the AC wall socket and telephone jack (if applicable) 
before cleaning. Do not use liquid or aerosol cleaners. Use only a damp cloth for 
cleaning.

 

6

 

Do not place the product on an unstable cart, stand, or table. It may fall, 
causing serious damage.

 

7

 

Your product should never be placed on, near, or over a radiator, heater, air 
conditioner, or ventilation duct.

 

8

 

Do not allow anything to rest on the power. Do not locate your product where 
the cords will be abused by persons walking on them.

 

9

 

Do not overload wall outlets and extension cords. This can diminish 
performance, and may result in the risk of fire or electric shock.

 

10

 

Do not allow pets to chew on the AC power, telephone, or PC interface cords.

 

11

 

Never push objects of any kind into the product through case or cabinet 
openings. They may touch dangerous voltage points, creating a risk of fire or 
shock. Never spill liquid of any kind onto or into the product.
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12

 

Your product may have a heavy cover for optimal pressure on the document for 
the best scanning and/or faxing (usually the flatbed-type product). In this case, 
replace the cover after placing document on the scan glass, by holding and 
moving it down slowly until it seats on its location.

 

13

 

To reduce the risk of electric shock, do not disassemble the product. Take it to a 
qualified service technician when repair work is required. Opening or removing 
covers may expose you to dangerous voltages or other risks. Incorrect 
reassembly could cause electric shock when the unit is subsequently used. 

 

14

 

Unplug the product from the telephone jack, PC and AC wall outlet, and refer 
servicing to qualified service personnel under the following conditions:

• When any part of the power cord, plug, or connecting cable is damaged or 
frayed.

• If liquid has been spilled into the product. 

• If the product has been exposed to rain or water.

• If the product does not operate properly after instructions have been followed.

• If the product has been dropped, or the cabinet appears damaged.

• If the product exhibits a sudden and distinct change in performance.

 

15

 

Adjust only those controls covered by the operating instructions. Improper 
adjustment of  other controls may result in damage, and may require extensive 
work by a qualified service technician to restore the product to normal 
operation.

 

16

 

Avoid using this product during a lightning storm. There may be a remote risk of 
electric shock from lightning. If possible, unplug the AC power and telephone 
cord for the duration of the lightning storm.

 

17

 

SAVE THESE INSTRUCTIONS.
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Thank you for purchasing the Samsung SCX-1150F InkJet 
All in One. This multifunctional product provides printing, 
copying, scanning, and faxing functions!

 

This chapter provides step-by-step instructions on 
setting up the product, installing the software, and basic 
system setup. The chapter includes:

 

•Setting Up Your Product

 

Contents
Control Locations and Functions
Operation Panel Button Functions
Choosing a Location
Making Connections
Loading Paper
Installing Print Cartridges

 

•Installing Software

 

About Samsung Software
System Requirements
Installing Samsung Software
Configuring Fax and Internet Gates
Uninstalling Samsung Software

 

•Basic System Setup

 

Setting Date and Time
Setting Fax Number and Name
Changing the Display Language
Setting the Discard Size
Setting Sounds
Setting Dialling Mode
Using Save Mode
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1.2

 

Set Up

 

Setting Up Your 
Product

Contents

Below is what is included with your product.

SCX-1150F Colour and Black ink cartridges

Telephone line cord* Power cord*

* The shape of the power and the telephone line cord plugs may differ,
depending on your country.

TAM lead (UK only) USB cable

This User’s Guide SmarThru User’s Guide

Quick Install Guide, 
Warranty Card(s)

Software CD
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1.3Set Up

 Control Locations and Functions

Take a moment to familiarize yourself with the main components 
of your product.

Front View 

Paper Output Tray 
Extension

Paper Output Tray

Operation Panel
(see page 1.5)

Cartridge Door
Grab the handle of the
door and open it wide.

Cartridge HolderCartridge Holder

Automatic
Document Feeder

Document 
Cover

Document Glass
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1.4 Set Up

Rear View

Top View

USB
Connector

ADF(Automatic Document
Feeder) Connector

Parallel
Connector

AC Power
Socket

Telephone
Connections

Connector Door
To access connectors, open it 
wide.

Paper Guide

Paper Bin

Paper Support

Document
Output Tray

Document
Input Tray

Document Guides

If your country has a different 
telephone connection system, 
this socket may be blocked.

Download from Www.Somanuals.com. All Manuals Search And Download.



1.5Set Up

Operation Panel Button Functions

1

Allows you to save ink to a maximum of 50% by 
printing images lighter (available in PC print, 
Copy, and Fax receiving modes).

Allows you to save paper by printing 2 pages on 
a single sheet of paper (available in Black&white 
Fax/Copy modes only).

Allows you to save on call costs by sending a fax 
at a preset time. By using this feature, you can 
take advantage of lower long distance rates at 
night, for example (available in Fax sending 
only).

2
Launches Samsung Scan Wizard in the desktop 
window from which you can select the scan 
destination and adjust scan settings.

3

Adjusts the copy quality.

Selects the number of copies.

Makes a copy smaller or larger than the original.

Allows you to set up special copy features 
including Fit to Page, Clone, Poster, and Mirror 
copy.

Makes a black and white copy.

Makes a colour copy.

: Scan mode : Copy mode : Common : Fax mode
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1.6 Set Up

4

Displays current status and prompts during 
operation.

Enters menu mode.

Scrolls through the menu items. Also used to 
adjust the volume.

Confirms the selection on the display.

Cancels a current operation including PC printing 
or resets the copy and fax setting item (Quality, 
Copy Page, Zoom Rate, Resolution or Contrast) 
to its default setting.

Adjusts the contrast of the documents for the 
current fax or copy job.

5 Use to dial a number or enter alphanumeric 
characters.

6

Use to choose the receive mode. The selected 
mode is displayed in Standby mode.

Adjusts the resolution of the documents for the 
current fax job.

Searches for numbers in memory. Also use to 
delete digits in the edit mode.

Sets your product to forward incoming faxes to 
another fax number.

Redials the last number or inserts a pause into a 
fax number. You can also view and dial any of the 
last numbers you dialled or received. 

Engages the telephone line.

Starts to send a black and white fax.

Starts to send a colour fax.

Use to store frequently dialled fax numbers and 
dial them with a single press.

Stores frequently dialled fax numbers and dial 
them using a 2-digit speed number.
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1.7Set Up

Choosing a Location

To achieve trouble-free operation of your product, place it on a 
flat, stable surface near your workstation. Leave enough space to 
allow for easy paper loading, paper out and opening the top cover.

Do not place your product:

• In direct sunlight.

• Near heat sources or air conditioners.

• In dusty or dirty environments. 

Making Connections

1 Open the connector door.
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1.8 Set Up

2 Connect the supplied telephone line to the LINE jack and the 
other end to the wall jack.

If you want to use your product for receiving both faxes and 
voice calls, you will need to connect a telephone and/or 
answering machine to your product. 

Plug the cord of your extension phone or answering machine 
into the EXT jack on the back of your product.

NOTES: 
• This product is intended for connection to analogue telephone 

networks in the United Kingdom. It is strongly recommended to use 
the TAM lead and the telephone line cord supplied with your 
product.

• If you are replacing the line cord with other manufacturer’s, it 
should be AWG #26 or lower guage.

TAM lead (applicable only in UK)
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1.9Set Up

3 Connect the printer cable. Use either the USB cable that came 
with your product or an IEEE-1284 compliant parallel cable 
purchased separately. 

NOTES: 
• You only need to connect one of the above cables. Shut down your 

computer before connecting the cable.
• When you are using a USB cable, you must be running Windows 

98/Me/2000/XP. 
• When using USB connection, your product provides two USB 

modes: Fast and Slow. Fast is the default mode. Some PC user may 
experience poor USB implementation in the default mode. If this 
occurs, select Slow mode to achieve successful results. For details 
on changing the USB mode, see page 7.14.

4 Close the connector door.

Parallel connection

OR

USB connection
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1.10 Set Up

5 Connect the power cord. 

Plug one end of the supplied three-wire electrical grounding 
type cord into the back of the product and the other end into a 
properly grounded AC outlet. 

As you plug it in, your product will turn on. “POWERING UP 
PLEASE WAIT” appears on the display indicating the product is 
on. To view your display text in another language, see page 
1.39.

If you want to turn your product off, unplug the power cord.

NOTES: When you first set up the product, you see “CHECK 
CARTRIDGES” on the display. Load the paper (see page 1.11), then 
install the print cartridges (see page 1.13).
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1.11Set Up

Loading Paper

The display will show “ADD PAPER THEN PRESS ENTER” if no 
paper is loaded when starting to print a job. The paper bin can 
hold approximately 100 sheets of 20lb plain paper.

In the Fax or Copy mode, you can use A4-, letter-, or legal-size 
paper.

To load plain paper:

1 Pull the paper support on the paper bin all the way up.

2 Fan the paper and then insert it with the print side facing 
you. Ensure that the right edge of  the paper is in contact 
with the right side of the paper bin. Do not exceed the 
specified capacity. 

NOTES: 
• Do not force the paper down into the printer.
• It is recommended to load a stack of paper (more than 20 sheets) 

to ensure proper paper feeding. 

Paper support
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1.12 Set Up

3 Squeeze the left paper guide and move it to the right to match 
the width of the paper.

4 Pull the output tray and the output tray extender on the front 
of the product all the way out.

NOTES:
• Your product emits warning tones when the paper bin is empty due 

to one of the following reasons:
- The paper does not load when starting to print a job.
- It runs out of paper while printing.

The LCD display shows “ADD PAPER THEN PRESS ENTER.”  To start 
or continue the print job, install paper into the paper bin then press 
the Enter button.

• If you are using legal-size paper, 
do not pull the output tray out. 
Push it in, or it may cause a 
paper jam when the paper prints 
out.

• After you load paper, you have to set up your product for the paper 
size you have used. See page 3.2 for copying, 5.42 for faxing, or 
2.10 for PC printing.

Paper guide
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Installing Print Cartridges

Your product comes with a black and a colour cartridge. You can 
purchase an optional photo cartridge and install it instead of the 
black cartridge. See page 1.17 for the options you can purchase.

When the product is turned on without the print cartridges 
installed, the display shows “CHECK CARTRIDGES.”

Use this procedure when installing print cartridges for the first 
time. To install replacement print cartridges, refer to “Replacing 
Print Cartridges” on page 6.9.

NOTE: There are two types of black and colour cartridge: Standard 
and High yield. Before proceeding to install, you need to check which 
cartridge type you have. When you install the cartridges, you will be 
asked if it is Standard or High Yield. To find out the type, please refer 
to the table on the page 6.9.

1 Unwrap and remove the colour print cartridge from its plastic 
bag. Hold the print cartridge at the top only. Do not touch the 
electrical contacts.

Carefully remove the sealing tape covering the print head. 

2 Grab the handle on the cartridge door and open the door. 

Grab the handle.
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1.14 Set Up

3 The cartridge holder moves to the install position. 

The colour cartridge is inserted into the left side of the 
cartridge holder and can be identified by a yellow tab on the 
top of the holder. 

The black (or photo) cartridge is inserted into the right side of 
the cartridge holder and can be identified by a green tab on 
the top of the holder.

4 Place the colour print cartridge into the left side of the holder.

5 Push the colour cartridge back until it clicks into place.

Yellow tab indicates
colour cartridge position.

Green tab indicates black or
photo cartridge position.

Colour ink cartridge
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1.15Set Up

6 Unwrap and remove the black print cartridge from its plastic 
bag. Holding the cartridge at the top, carefully remove the 
sealing tape covering the print head. 

Place the black print cartridge into the right side of the holder. 

7 Push the black print cartridge back until it clicks into place.

8 After installing the print cartridges, close the cartridge door.

NOTE: If the display shows “REMOVE PAPER JAM AND PRESS 
CANCEL” when you have closed the cartridge door, re-install the 
cartridge(s). With the print cartridge(s) installed improperly, the 
product might not print.
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1.16 Set Up

9 When you close the door, the display shows “CARTRIDGE 

CHANGED? NO.”  Press the Scroll buttons (  or ) until you 
see “BOTH” at the bottom right corner of the display and then 
press Enter.

10 The display shows “LEFT CARTRIDGE NEW COLOR”. Press 
Enter to confirm you have installed a new colour cartridge.

11 The display shows “LEFT CARTRIDGE STANDARD COLOR”. If 
you have installed a standard capacity colour cartridge, press 
Enter. If not, press the Scroll buttons (  or  ) to display 
“LEFT CARTRIDGE HIGH YIELD COLOR” and then press Enter.

12 The display shows “RIGHT CARTRIDGE NEW BLACK”. Press 
Enter to confirm you have installed a new black cartridge.

13 The display shows “RIGHT CARTRIDGE STANDARD BLACK”. If 
you have installed a standard capacity black cartridge, press 
Enter. If not, press the Scroll buttons (  or  ) to display 
“RIGHT CARTRIDGE HIGH YIELD BLACK” and then press 
Enter.

14 The cartridge holder returns to the home position. The 
Cartridge Alignment procedure begins automatically by 
printing a Cartridge Alignment form. 

Use this form to identify the straightest line in each of six 
alignment areas. By selecting the straightest line for each 
pattern, you will optimise the print head alignment.
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1.17Set Up

15 Looking at the Cartridge Alignment form, identify the 
straightest line in Alignment A. Using the number keypad, 
enter the two digit number of the straightest line and then 
press Enter. 

16 The display accepts the number and moves to Alignment B. 
Repeat step 15 for Alignment patterns B-F.

17 When you finish entering the number for Alignment F, the 
display returns to Standby mode.

Then the display prompts you to set the current date and 
time. See page 1.33 to set the date and time.

NOTES:
• Keep a spare print cartridge on hand. When buying print 

cartridges, check the part numbers referenced below to ensure 
buying the correct print cartridge. These print cartridges have been 
specifically designed to work with your product to produce results 
that are always clear and sharp.

• If you want to purchase a new print cartridge, either contact your 
point of purchase or any Lexmark authorised supplies dealer.

Cartridge type Part number

Black cartridge

High yield Lexmark 12A1975

Standard Samsung INK-M50 
Lexmark 12A1970

Colour cartridge

High yield Lexmark 15M0125

Standard Samsung INK-C60 
Lexmark 15M0120

Photo cartridge Lexmark 12A1990

Last Alignment
Entry

Number Range Alignments 
(A, B, C, D, E, F)
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Installing Software

About Samsung Software

You must install the SmarThru CD-ROM after you have setup your 
product and connected it to your computer. The SmarThru CD-ROM 
includes the following:

• MFP Driver

• SmarThru Software

• OCR Software (AnyPage Lite)

MFP Driver 

To use your product as a printer and scanner, you must install the 
MFP driver.

SmarThru Software

SmarThru is the accompanying software for your SCX-1150F 
multifunctional product. SmarThru contains a powerful image 
editor that allows you to edit images in many ways and also 
includes a powerful Internet mail client software. With SmarThru, 
you can save the scanned images in a dedicated storage area for 
subsequent editing, sending via e-mail or fax, printing, and 
processing by other programs of your choice. 

OCR Software (AnyPage Lite)

OCR (Optical Character Recognition) is software that has the ability 
to recognise most character formats, so that a scanned document 
can be read and edited with word processing software. 
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System Requirements

Before you begin, ensure your system meets the minimum 
requirements.

Supported Operating System

Windows 95 OSR2/Windows 98/Windows Me/Windows NT 4.0 
Workstation or Server with Service Pack 3/Windows 2000 
Professional or Server/Advanced Server/Windows XP Home edition 
or Professional.

Minimal Requirements

• Disk space: 130 MB for installation 

• Memory: 64 MB 

• CPU: Pentium II 233

• Required software: Internet Explorer 4.01

Recommended

• Disk space: 250MB for installation database

• Memory: 128MB

• CPU: Pentium II 400 or higher

• Required software: Internet Explorer 5.5 or above

NOTES: 
• Administrative rights should be set for installation on Windows 

NT4.0/2000/XP.
• Windows 95 versions prior to OSR2 are not recommended due to 

compatibility with OLE/COM libraries.
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Installing Samsung Software

NOTES: 
• For Windows 95/98/Me/2000/XP users, cancel the “New Hardware 

Found” screen when the computer boots up.
• Make sure that your SCX-1150F is plugged in and connected to 

your computer’s parallel port or USB port before installing the 
software from the CD. Windows 95 and Windows NT 4.0 do not 
support USB connection.

1 Insert the supplied SmarThru CD-ROM into your CD-ROM 
drive.

The SmarThru CD-ROM should automatically run and the 
opening window appears.

If the opening window does not appear, click Start, and then 
Run. Type X:Autorun.exe, replacing “X” with the letter of 
your drive, and click OK.

If you are asked to select the language, choose the desired 
language.

2 Click Install the Samsung Software on your PC. 

3 Follow the on-screen instructions and click Next. 

Installs the 
Samsung 
Software on 
your PC

Uninstall the 
Samsung 
Software. See 
page 1.28.
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4 The SmarThru installation supports three types of setup:

• Typical: Program will be installed with the most common 
options and is recommended for most users.

• Compact: Only the MFP driver will be installed.

• Custom: You may choose the options you want to install. 
Recommended for advanced users.

5 Click Next. 

If you select the Custom installation, you may choose the 
options you want to install.

• SmarThru Software: to scan and edit images and 
   work with electronic documents.
• OCR Software: AnyPage Lite software to enable OCR. 
• MFP Driver: to print and scan.
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6 You can choose SmarThru networking option. This feature 
allows you to share the modems on your computer and the 
scan device SCX-1150F via a network or to access these 
shared devices located on other computers. 

Stand-alone configuration does not allow you to use any 
networking features such as Remote Fax or Remote Scan 
service.

If you selected SmarThru networking, you can select to 
install server, client, or both. 

Server allows you to share local fax modem and/or scanner 
over a LAN. You can control sharing by managing remote 
service user. Client allows you to use Remote Fax or Remote 
Scan services provided by SmarThru Remote Services Server 
over a LAN. You need to have a client account. These accounts 
are provided by the server. For details on Remote Fax/Scan 
Services, please refer to the SmarThru User’s Guide.
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7 Click Next.

8 When the installation is completed, shut down and restart 
your computer. 

If your computer does not shut down and restart 
automatically, you must shut it down manually and restart it 
before the changes will be saved.

NOTE: When you install the software, the Digital Signature Not 
Found window may appear in Windows 2000 and Windows XP. Click 
OK in Windows 2000 and click Continue Anyway in Windows XP.
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Configuring Fax and Internet Gates 

If you select SmarThru networking Server option (see page 
1.22), when your computer restarts after the Samsung software 
has installed, you will be prompted to configure the fax and 
Internet gates allowing you to send and receive faxes and e-mails 
on the SmarThru system.

If you select the Stand-alone or SmarThru networking Client 
option (see page 1.22), the following wizards appear only the first 
time you try to launch the Mailbox in the SmarThru program. For 
information on SmarThru, please refer to the SmarThru User’s 
Guide.)

NOTE: To configure the Internet gate, you must enter your e-mail 
address, incoming (POP3 or IMAP4) and outgoing (SMTP) mail server 
address, and account name. Ask your Internet service provider or on-
line service provider for the information on your Internet gate 
configuration.

1 When the New Modem Wizard appears, choose the system 
modem installed in your system and then click Next. This fax 
modem will be used by SmarThru Fax Gate for sending and/or 
receiving faxes.

2 Click Finish to save the modem setting.
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3 Enter your name and e-mail address, then click Next. The 
e-mail address will have been assigned to you by your 
Internet service provider.

4 Enter the addresses of your incoming and outgoing mail 
servers. Choose the incoming mail server type, then click 
Next. Your Internet service provider will be able to provide 
you with this information.
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5 Enter your account name and password to access your 
Internet mail server, then click Next. Your Internet service 
provider will be able to provide you with this information.

6 Enter an account record name, then click Next. 
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7 Click Finish to quit the wizard and enable Internet e-mail 
service.

NOTE: If you wish, you can reconfigure the Internet gate later by 
using SmarThru Configuration. For details, refer to the SmarThru 
User’s Guide.
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Uninstalling Samsung Software

Uninstall is required if you are upgrading the software or if your 
installation fails. You can uninstall all software including SmarThru 
and MFP drivers using the SmarThru CD or selectively uninstall the 
desired item using the Window unInstallShield.

NOTE: Before beginning un-installation, ensure all applications are 
closed on your PC. A system reboot is required after the software is 
uninstalled.

Uninstalling the MFP Driver

1 From the Start menu, select Programs, then select 
Samsung SCX-1150 Series.

2 You can select the component in the MFP driver to uninstall 
individually.

If you want to uninstall the scan driver, select TWAIN Driver 
Uninstaller.

If you want to uninstall the printer driver, select Printer 
Driver Uninstaller. Restarting your computer will be 
required.

In the case of Windows 98 
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3 When your computer confirms your selection, click Yes. The 
selected printer driver and all its components are removed 
from your computer.

4 When the uninstallation is done, click OK. 

5 The message box recommends you restart your computer. 
Click OK, then restart Windows.

NOTE: If you want to install the printer driver or the scan driver 
using the SmarThru CD-ROM, make sure that you select the Setup 
Type to Compact. Or select Custom then select MFP Driver. For 
details, see page 1.21

Uninstalling Samsung SmarThru

1 From the Start menu, select Programs.

2 Select Samsung SmarThru, then select SmarThru 3 
Uninstall.
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3 When your computer asks you to confirm your selection, click 
Yes. The Uninstall Options dialog box appears.

Uninstall options are:

• Backup and delete: Backs up all your data and options to a 
safe place. Then removes SmarThru system including the 
data.

• Delete: Deletes all the SmarThru data and options. No 
backup or copying takes place. Be careful while using this 
option as you can easily lose your data.

• Leave intact: Uninstalls SmarThru software leaving data 
and option intact. This can be useful, if, for example, you 
decide to install Stand Alone configuration over SmarThru 
Networking. In this case, uninstall Samsung SmarThru 
having Leave intact option set and install SmarThru Stand 
Alone configuration.

4 After selecting the uninstall option, click Next.
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5 Follow the on-screen instructions to complete the 
uninstallation. The SmarThru software and all components will 
be removed. 

6 When uninstalling is done, click OK. The message box 
recommends restarting your computer.

7 Click OK.

Shut down and restart your computer to complete the 
uninstallation process and save your changes. 
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Using the SmarThru CD-ROM

You can uninstall both the MFP driver and the SmarThru software 
with the CD-ROM you have used to install the software. 

1 Insert the SmarThru CD-ROM into your CD-ROM drive. 

The SmarThru CD-ROM should automatically run and the 
opening window appears. (If the opening window does not 
appear, select Run from the Start menu, then type 
X:Autorun.exe, replacing “X” with the letter of your drive 
and click OK.

If you are asked to select the language, choose the desired 
language.

2 Click Uninstall the Samsung software on your PC. 

3 Follow the on-screen instructions to complete uninstallation.

You must shut down and restart your computer before any 
changes you have made will take affect.
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Basic System Setup

Setting Date and Time

If you are setting up the product for the first time, or if the product 
has been unplugged for an extended period of time, the LCD 
display prompts you to set the current date and time. 

The current date and time are shown on the display when the 
product is in Standby mode. The time and date are also printed on 
all faxes you send.

In Standby mode, you can also access the date and time setup 
menu any time by taking the following steps:

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press Enter. The display shows “FAX NUMBER/NAME” on the 
bottom line.

3 Press the Scroll buttons (  or ) until you see “DATE/TIME” 
and then press Enter. The date currently set for the product 
are displayed.
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Take the following steps to enter your current date and time:

1 A flashing cursor prompts you to enter the date. Use the 
number keypad to enter the current date. You can use the 
Scroll buttons (  or ) to manually move the cursor to a 
digit you wish to change. 

The default is the Europe format D-M-Y (Day-Month-Year). You 
can change the date format to the USA format M-D-Y (Month-
Day-Year). See page 1.35.

2 Press Enter when the date on the display is correct.

If you enter an invalid number, the product beeps and does 
not proceed to the next step. If this happens, just re-enter the 
correct number.

3 The display asks you to enter the time. Use the number 
keypad to enter the current time using a 24-hour format (e.g. 
1:00 PM as 13:00).  

You can change the clock mode to 12-hour format. Use the 
Scroll buttons to select AM or PM. See page 1.35.

4 Press Enter when the time on the display is correct. The 
display automatically returns to Standby mode.

Current date Current time

Remaining memory

Fax receiving mode. 
For details, see page 
5.13.
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Changing Date Format

Your product displays the current date in Europe format. Europe 
format displays the date in the order of Day-Month-Year. You can 
change the date format in USA format (Month-Day-Year).

Take the following steps to change the date format:

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press Enter. 

3 Press the Scroll buttons (  or ) until you see “DATE 
FORMAT” and then press Enter. The date format currently set 
for the product is displayed.

4 Press the Scroll buttons (  or ) to select the other format 
and then press Enter to save the selection.

Changing Clock Mode

You can configure the product to display time using either a 12-
hour or 24-hour format.

Take the following steps to change the clock mode:

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press Enter. 

3 Press the Scroll buttons (  or ) until you see “CLOCK 
MODE” and then press Enter. The clock mode currently set for 
the product is displayed.

4 Press the Scroll buttons (  or ) to select the other mode 
and then press Enter to save the selection. 
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Setting Fax Number and Name

In some countries you are required by law to indicate your fax 
number on any fax you send. The fax number and name will be 
printed at the top of each page sent from your product.

NOTE: Depending on your country, the Fax Number/Name setting 
may be unavailable.

1 Press Setup on the operation panel. The display shows 
“1.SYSTEM SETUP” on the bottom line.

2 Press Enter to access the System Setup menu.

3 The display shows the first option “FAX NUMBER/NAME” on the 
bottom line. Press Enter to access the Fax Number/Name 
menu.

The displays asks you to enter the fax number. If there is a 
number already set, the number appears.

4 Enter your fax telephone number. You can include + symbol in 
the phone number by pressing the  button and insert a —
symbol by pressing # button.

If you make a mistake, move the cursor under the wrong digit 
by pressing the Scroll buttons (  or ). Press the correct 
number to change. To delete a number, press Search/
Delete.

5 Press Enter when the number on the display is correct. The 
display asks you to enter the name.

6 Enter your name or company name by using the number 
keypad.

For details on how to use the number keypad to enter 
alphanumeric characters, see 1.37.

7 Press Enter when the name on the display is correct. The 
display automatically returns to Standby mode.
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How To Enter Characters Using the Number 
Keypad

As you perform various tasks, you’ll need to enter a name. For 
example, when you set up your product, you enter your name (or 
your company’s name). When you store numbers in memory, you 
may also enter the corresponding names.

To enter alphanumeric characters:

1 When prompted to enter a name, locate the button labeled 
with the character you want. 

Press the button repeatedly until the 
correct letter appears in the display.

For example, to enter the letter O, press 6, 
(labeled MNO).

Each time you press 6, the display shows a 
different letter, first M, then N and O, and 
finally 6.

You can enter special characters (space, plus sign, etc.). For 
details, see “Keypad Character Assignment” on page 1.38.

2 To enter additional letters, repeat Step 1.

If the next letter is printed on the same button, move the 
cursor by pressing the Scroll button ( ), then press the 
button labeled with the letter you want.

The cursor moves right and the next letter appears in the 
display.

If you want to insert a space in the name, you can also use 
the Scroll button ( ) to move the cursor and skip the 
position.

3 When you finish entering letters, press Enter.
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Keypad Character Assignment

Editing Numbers or Names

If you make a mistake, move the cursor under the wrong character 
by pressing the Scroll buttons (  or ) and enter the correct 
number to change. To delete a letter, press Search/Delete.

Inserting a Pause while Entering a Number

With some telephone systems, you must dial an access code (9 for 
example) and listen for a second dial tone. In such cases, you must 
insert a pause in the telephone number. You can insert a pause 
while you are setting up speed dial numbers.

To insert a pause, press Redial/Pause at the appropriate place 
while entering the telephone number. A “P” will appear in the 
display at the corresponding location.

Key Assigned numbers, letters or characters

1 Space    1

2  A    B    C    2

3  D    E    F    3

4  G    H    I    4

5   J    K    L    5

6  M    N    O    6 

7   P    Q    R    S    7

8   T    U    V    8

9   W    X    Y    Z    9

0   +    -    ,    .    ‘    /    *    #    &    0
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Changing the Display Language

To change the language that is used on the LCD display, take the 
following steps:

1 Press Setup on the operation panel. The display shows 
“1. SYSTEM SETUP” on the bottom line.

2 Press Enter. 

3 Press the Scroll buttons (  or )until you see “LANGUAGE” 
on the bottom line, then press Enter.

The current setting displays.

4 Press the Scroll buttons (  or ) until you see the language 
you want in the display.

5 Press Enter to save the selection.
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Setting the Discard Size

When receiving or copying a document as long as or longer than 
the paper loaded in the paper bin, you can set the product to 
discard and excess images at the bottom of the page, so that it will 
fit onto the recording paper size. 

NOTE: If the Auto Reduction feature is turned ON for printing faxes, 
this function is not performed.

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press Enter. 

3 Press the Scroll buttons (  or ) until you see “DISCARD 
SIZE” and then press Enter. 

4 Enter the desired discard size using the number keypad.

The received or copied page within the margin you set will be 
discarded.

If the data is outside the margin you set, it will be printed on 
two sheets of paper at the actual size. 

5 Press Enter to save the selection and return to Standby 
mode.
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Setting Sounds

You can set the following sounds:

• Ringer Volume: You can adjust the ringer volume. Choose from 
HIGH, MED, LOW, or OFF. OFF setting turns the ringer off.

• Alarm Sound: You can turn the alarm sound on or off. If set to 
ON, an alarm sounds when an error occurs.

• Key Sound: You can turn the key tone on or off. If set to ON, key 
tone sounds are heard when a key is pressed.

• Speaker Volume: You can adjust the volume of the earpiece to 
the desired loudness.

 

Ringer Volume, Alarm Sound, Key Sound

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press Enter. 

3 Press the Scroll/Volume buttons (  or ) until you see the 
desired sound you want to set and then press Enter. The 
current setting for the selected sound displays.

4 Press the Scroll/Volume buttons (  or ) until you see the 
desired volume setting on the display and then press Enter to 
save the selection. 

Speaker Volume

1 Press OHD. You will hear a dial tone.

2 Press the Scroll/Volume buttons (  or ) until you hear 
the desired loudness. The display shows the selected volume 
level.

3 Press OHD to save the selection and return to Standby mode.
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Setting Dialling Mode

You can select the type of telephone dial system your product is 
connected to. 

NOTE: The Dialling Mode setting may be unavailable depending on 
your country.

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press Enter. 

3 Press the Scroll buttons (  or ) until you see “DIALLING 
MODE” and then press Enter. 

4 Press the Scroll buttons (  or ) to select the desired 
setting.

Select “TONE” if the product is connected to a tone dial line.
Select “PULSE” if the product is connected to a pulse dial line. 

5 Press Enter to save the selection.
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Using Save Mode

Ink Save

The Ink Save feature allows the printer to use less ink on each 
page. Activating this mode will extend the life of the ink cartridges 
by up to twice as long compared to normal mode, but will reduce 
the print quality. 

To use the Ink Save mode, press SAVE Ink on the operation panel. 
If the button backlight is on, the Ink save mode is active and the 
printer uses less ink when printing from PC, receiving faxes, and 
printing copy pages.

If the button backlight is off, the Ink Save mode is disabled and you 
will print with normal quality.

NOTE: The Ink Save mode is not activated if the Paper Save mode is 
on or an optional photo cartridge is installed in the product.

Paper Save

This feature prints 2 pages on a single sheet of paper to save paper. 

To save paper:

1 Press SAVE Paper on the operation panel. The display shows 
the current setting on the bottom line.

2 Press the Scroll buttons (  or ) to change the setting. To 
enable the Paper Save mode, select “ON”. Or select “OFF” to 
disable the mode. Then press Enter.

NOTES: 
• The Paper Save feature is applied only in Black Copy or Fax mode. 

While the Paper Save feature is enabled, you cannot enlarge or 
reduce the image using the Zoom Rate button. The copy quality is 
also fixed to Normal. You cannot change the quality using the 
Quality button unless you disable the Paper Save feature.

• The Paper Save feature may not work when copying or receiving 
long documents (for example, legal size) because Auto Reduction 
cannot be achieved.

Download from Www.Somanuals.com. All Manuals Search And Download.



1.44 Set Up

Power Save 

Your product reduces power consumption when it is not in actual 
use. This Power Save Mode setting allows you to select the length 
of time the product waits after a job is printed before it switches to 
a reduced power state.

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press Enter. 

3 Press the Scroll buttons (  or ) until you see “POWER 
SAVE MODE” on the display and then press Enter. The current 
setting displays.

4 Press the Scroll buttons (  or )until you see the desired 
time on the display. The available options are 1 HOUR, 4 
HOURS, 8 HOURS, and 12 HOURS.

5 Press Enter to save the selection. 

NOTE: If the product detects a document(s) in the ADF, the Power 
Save mode is not activated. Do not leave documents in the ADF if not 
used.
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2 PRINT

Read this chapter to learn how to select and load print 
media and how to use the print settings. 

The topics included in this chapter are:

•Paper Selection

•Loading Speciality Paper

•Printing a Document

•Printer Settings

•Using the Printer Control Program
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Paper Selection

One of the most important things you can do to assure the best 
possible printing performance of your product is to select the 
correct paper. Your product produces letter quality print on most 
plain bond paper, including cotton bond and photocopying paper; it 
does not require special ink jet paper. However, the print quality 
varies with different paper types. Be sure to test a type of paper 
before you purchase a large quantity.

Your printer supports the following types of paper. Select the right 
paper for the job you intend to use it for.

• Plain Paper
The product supports paper sizes of letter, legal, and A4 in 
portrait orientation. You can use regular copier paper, cotton bond 
papers, and typical letterhead. Always use paper without curls, 
folds, staples, or damaged edges.

• Coated paper
Paper developed for high quality printing with minimal or no 
smearing or running when in contact with water or damp 
surfaces.

• Glossy/Photo Paper
A high gloss, thicker paper that produces the look and feel of a 
photograph. Use this paper to produce photo-realistic prints from 
your printer.

• Transparency
Your transparencies should be products designed for use in Ink 
Jet products, with excellent contrast, sharpness, and colour 
quality. The transparency is placed in the product with the image 
side up.

• Iron-on Transfer
Use inkjet T-shirt transfers to create and personalize T-shirts, 
sweatshirts, aprons, tablecloths, napkins, tote bags, and 
anything else your imagination allows! Use on any cotton or 
cotton/poly blend fabric. Your image is printed in mirror image so 
when you iron it onto the T-shirt, the image is viewed correctly.

• Greeting Card Stock
You can create greeting cards, business cards, invitations, 
announcements, and more.
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NOTE: When you print on these special type of media, you have to 
set the selected paper type in your application. See page 2.10.

Guidelines for Special Media

Be sure to read any instructions that come with your special paper. 
These instructions provide important information regarding how to 
achieve the highest print quality with these papers.

• It is recommended that you feed special paper types one sheet 
at a time.

• For transparencies and glossy photo paper, follow these 
guidelines:

• Let the printed sheets dry completely before storing them.

• When a printed sheet has dried completely, cover the printed 
   side with a sheet of plain (not coated) paper before storing it, 
   this is recommended even if you place the sheets in a clear file 
   or plastic holder.

• Do not leave the film in the paper output tray for long periods 
   of time. Dust and dirt may accumulate on the film resulting in 
   spotty printing.

• To avoid smudging caused by fingerprints, handle transparency 
   film and coated paper carefully.

• To avoid fading, do not expose the printed film to prolonged 
   sunlight. 

• Store unused media flat. Do not remove paper from their 
protective packaging until you are ready to use them.

Select the
paper type

In the case of Windows 98
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• Store unused media at temperatures between 59 and 86 oF (15 
to 30 oC). The relative humidity should be between 10% and 
70%.

• If the print density of your page is very high, light paper stock 
may curl slightly due to the large amount of ink. If you need to 
print dense graphics, try printing on heavier stock.

• Do not use thicker paper than meets the specifications for this 
product. Printing with a paper that is thick enough to come in 
contact with the print head nozzles may damage the cartridge.

Loading Speciality Paper

Follow these guidelines when loading specialty paper:

Load up to: And make sure:

100 sheets of  
plain paper 
(depending on 
thickness)

• The print side is facing you.

• The paper is against the right side of the paper support.

10 envelopes • The print side is facing you.

• The envelopes are loaded vertically 
against the right side of the paper 
support.

• The stamp location is in the upper 
left corner.

• The paper guide rests against the edge of the envelopes.

10 greeting cards, 
index cards, 
postcards, or 
photo cards

• The print side is facing you.

• The cards are loaded vertically against the right side of the 
paper support.

• The paper guide rests against the edge of the cards.

25 sheets of 
photo paper

• The glossy or coated side is facing you.

• The paper guide rests against the edge of the photo paper.
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Paper Guidelines

When loading paper, envelopes, or other special media, keep these 
guidelines in mind:

• Attempting to print on damp, curled, wrinkled, or torn paper can 
cause paper jams and poor print quality.

• Use only high quality inkjet or copier grade paper. Avoid paper 
with embossed lettering, perforations, or texture that is too 
smooth or too rough.

• Store paper in its ream wrapper until ready to use. Place cartons 
on pallets or shelves, not on the floor. Do not place heavy objects 
on top of the paper, whether it is packaged or unpackaged. Keep 
it away from moisture, or other conditions that can cause it to 
wrinkle or curl.

• During storage, moisture-proof wrap (any plastic container or 
bag) should be used to prevent dust and moisture from 
contaminating your paper.

• Always use paper and other media that conform with those listed 
under “Paper Specification” on page 8.5.

• Use only well-constructed envelopes with sharp, well creased 
folds.

• DO NOT use envelopes with clasps and/or snaps.

• DO NOT use envelopes with windows, coated linings, self-
adhesive seals, or other synthetic materials.

• DO NOT use damaged or poorly made envelopes.

10 transparencies • The rough sides of the transparencies are facing you.

• The paper guide rests against the edge of the transparencies.

100 sheets of 
custom size paper 

• The print side is facing you.

• Your paper size fits within these dimensions:
- Width: 76 mm to 216 mm (3.0 in. to 8.5 in.)
- Length: 127 mm to 432 mm (5.0 in. to 17.0 in.)

• The paper guide rests against the edge of the paper

25 iron-on 
transfers

• You follow the loading instructions on the iron-on packaging.

• The print side (blank side) is facing you.

• The paper guide rests against the edge of the iron-on 
transfers.

Load up to: And make sure:
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Printing a Document

This procedure describes the general steps required for printing 
from various Windows applications. The exact steps for printing a 
document may vary depending on the application program you are 
using. Refer to your software application’s documentation for the 
exact printing procedure.

 The following steps describe the typical process to print from a 
Windows environment:

1 Ensure that your Samsung SCX-1150F is properly connected 
to the computer, the product is powered on, and there is 
paper in the paper bin.

2 Verify that you have installed the Samsung software for your 
computer. For details, see “Installing Samsung Software” on 
page 1.20.

3 Start the program you are using to create the document, and 
create or open the document you want to print. 

4 Choose Print or Print Setup from the File menu. Make sure 
that Samsung SCX-1150 Series is selected as your default 
printer. Click Properties or Setup if you want to make any 
adjustments that are appropriate for printing your document. 
(For details, see “Printer Settings” on page 2.8.)
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5 Click OK to close the Properties dialog box.

6 After making any necessary changes to the printing 
parameters, click OK to start the print job.

After a moment, the Samsung SCX-1150 Series Control 
Program window appears. You can cancel the print job as well 
as see how much ink you have left and view printing tips in 
this window.

For Windows 2000/XP, the Control Program does not appear. 
Right-click on the printer icon on the taskbar at the bottom 
right corner of the desktop window. From the pop-up menu, 
you can select commands to cancel, pause, or resume 
printing.

NOTE: If you want to use another printer instead of SCX-1150F, you 
must disable the scan monitor on the taskbar at the bottom right 
corner of the desktop window. The scan monitor is enabled as long as 
SCX-1150F is connected to your computer and turned on. To disable 
the scan monitor, right-click on the scan monitor and select Disable 
from the pop-up menu.

In the case of Windows 98. The appearance of this window may 
be different depending on your Windows operation system.
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Printer Settings

You can use the product with all your Windows 95/98/Me/2000/XP 
or Windows NT 4.0 applications. Be sure to set Samsung SCX-1150 
Series as the default printer for all your Windows operations.

Most Windows software applications allow you to make changes to 
the printer settings. This includes settings that determine how a 
print job looks such as paper size, paper orientation, and margins. 
Settings made in the application to create the document will usually 
override settings made in the printer driver.

NOTE: You do not need to use any of the operation panel buttons to 
use the product as a PC printer. For example, if you want to adjust the 
printing contrast you do not have to press Contrast on the operation 
panel. The operation panel buttons are used primarily for copying.

Accessing Printer Settings

You can access printer settings by using either of these methods.

Windows 95/98/Me

• Select the File > Print > Properties or File > Print Setup 
command from  within any Windows application.

Or

• Select Samsung SCX-1150 Series printer from the Printers 
folder, then select File > Properties (or select the printer icon in 
the Printers folder, and click the right mouse button).

Windows NT 4.0

• Select the File > Print > Properties or File > Print Setup 
command from  within any Windows application.

Or

• Select Samsung SCX-1150 Series printer from the Printers 
folder, click the right mouse button, then select Document 
Defaults from the drop-down list.
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Windows 2000/XP

• Select the File > Print > Properties or File > Print Setup 
command from within any Windows application.

Or

• Select Samsung SCX-1150 Series printer from the Printers 
folder, click the right mouse button, then select Printing 
Preferences from the drop-down list.

Printer Properties Tabs (Windows 95/98/Me)

When the Printer Properties are displayed, you can review and 
change whatever settings are needed for your printer job.

Your printer’s Properties window consists of 4 tabs: Paper, 
Quality, Job Finishing and Advanced.

If you access the Printer Properties through the Printers folder, 
you can view more Windows-based tabs, as well as these 4 tabs. 
For information on the Windows-based tabs, refer to your Windows 
User Guide.

NOTE: If you access the Printer Properties through the Printers 
folder, any settings made will become the default settings for the 
printer. Settings made when the Printer Properties are accessed 
through an application File menu and Print or Print Setup will 
remain active until the application you are printing from is closed.
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Paper Tab 

Use the Paper tab to select what size paper you have in your 
printer, the orientation, the number of copies to print, etc.

Document/Quality Tab

The Document/Quality tab controls the document type and the 
paper type, such as plain, coated, and glossy. It also controls the 
quality (resolution) of the printing. Higher resolutions print better, 
but take longer and consume more ink. Selecting Web Smoothing 
allows you to print clearer images from the Internet.

Select the paper size you have 
loaded in your printer. If you 
have a special size of paper to 
print on, select Custom and 
define its size in the custom 
settings. The minimum paper 
size you can use is 3 by 5 inches. 
The maximum size is 8.5 by 17 
inches.

Resets to the default settings.

Shows the printer driver 
version.
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Job Finishing Tab

The Job Finishing tab provides options for you to adjust how the 
document will appear on the printed page. Job Finishing options 
can include Poster, Handout, Booklet and Two-sided printing.

Booklet

The Booklet option allows you to print a document out as a booklet. 
If the Print reloading instructions after the first side prints is 
checked, a page will print directing you how to insert the paper so 
that the booklet prints correctly.

A bundle is any number of sheets 
of paper folded together. When 
printing with a heavier paper 
stock, select a smaller number of 
Sheets Per Bundle.
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Once your document prints, stack the bundles and bind the booklet.

1 Take the first bundle from the paper output 
tray, fold it in half, and set it aside.

2 Fold and stack the rest of your bundles, one 
on top of the other, until your booklet is 
complete.

3 Bind the bundles.

Poster

Choose the Poster option to enlarge the printed document. If you 
check Show Crop Marks, the image will print with crop marks. The 
white space around the image can easily be trimmed.
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Handout

Choose the Handout option to print multiple pages on a single 
sheet of paper.

Two-Sided Printing

Choose the Two-sided printing option from the Job Finishing 
tab to print the document on both sides of the paper.
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Advanced Tab

The Advanced tab allows you to change how the printer handles 
colour printing. You should rarely need to change these settings.

Printer Properties Tabs (Windows NT 4.0)

Page Setup Tab

This tab allows you to set page properties including number of 
copies, collate, print quality, orientation, reverse order printing, 
paper size, and paper type.
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Color Tab

Use the Color tab for optimising the graphic and colour print job. 
You can adjust halftone shading, brightness and contrast. You can 
also select the colour appearance and the document colour. 

Feature Tab

You can select the Dry Time Delay option and the two-sided 
printing option. You can also access Cartridge Maintenance 
features from this tab.

NOTE: In Windows NT 4.0, Poster, Handout, and Booklet printing are 
not provided.
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Printer Properties Tabs (Windows 2000/XP)

Paper Quality Tab

This tab allows you to select paper source, paper type, print quality, 
and colour. The Advanced button under this tab allows you to 
select advanced document settings including paper size, print 
resolution, and colour intent. 

Layout Tab

Use the Layout tab to select print orientation, and page order. 
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Printer Properties Buttons & Icons
• Click OK when done reviewing or making changes.

• Click Cancel if you want to exit the tab menus without applying 
any changes.

• Click Help to view the online Help feature and tab menu details.

• Click the ? icon in the title bar. Position the ? pointer over the 
parameter in question and click to see a pop-up window 
explaining that parameter.

Using the Printer Control Program

The SCX-1150 Series Control Program contains setup options that 
define the operation of your product.

NOTE: The Printer Control Program is not available in Windows 2000 
and Windows XP.

Accessing the Printer Control Program

1 Click Start > Programs> SAMSUNG SCX-1150 Series> 
Printer Control Program.

NOTE: Windows NT 4.0 users can also access the Printer Control 
Program from the Printer Properties window. See 2.15.

2 The Samsung SCX-1150 Series Control Program window 
appears. The appearance of the window may be different from 
the ones on page 2.18 depending on your Windows operating 
system. Click the appropriate tab for the options you want to 
display, and make the necessary changes on each tab.

NOTE: Click Help on any tab in the Control Program window to 
access on-line Help.
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Status Tab

The Status tab gives you general status information on the printer. 
You will see this window when the printer is printing (unless you’ve 
set the Control Program Options to Run Minimized, using the 
options on page 2.18).

Once a print job has started, you can use this window to cancel the 
print job or monitor the job progress.

The ink level of your cartridges is also displayed. Use the gauges to 
help you determine when they need replacing.

Options Tab

From the Options tab, you can control some of the behaviour of 
the Control Program. The options available will vary depending on 
your Windows operating system. Some of the options activate 
under a specific printing environment such as network printing. 
Click Help for further information.

NT 4.0 provides this 
button in the Cartridge 
tab.

In the case of Windows 98

In the case of Windows 98
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Cartridges Tab

The Cartridges tab gives you access to several different cartridge 
functions. From here, you can install new cartridges, change them, 
clean your print nozzles, align your cartridges, or order supplies 
from the internet.

NOTE: If you using Windows 2000/XP, you can access the Cartridge 
Maintenance features through the printer properties by taking the 
following steps: 
1. Click Start > Settings > Printers.
2. Right-click on Samsung SCX-1150 Series printer in the Printers 
    folder.
3. From the pop-up list, select Properties.
4. Click the Cartridge Maintenance tab.

About Tab

The About tab gives you the program version number. If you click 
on the globe image on the window, you will be connected to the 
Samsung web site provided you are an internet user.

In the case of Windows 98

Not available in
Windows NT 4.0
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NOTE
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You can use your product like a standard copier. You don’t 
even have to turn your computer on. The buttons on the 
operation panel let you make all the basic settings: paper 
type and size, copy size, copy contrast and quality, number 
of copies, and colour copy or black and white copy. 

This chapter includes:

•Setting Paper Size and Type

•Loading the Original Documents

•Copying a Document

•Setting Copy Options

•Using Special Copy

•Changing Default Settings

•Blocking Colour Copying
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Setting Paper Size and Type

First make sure you have paper loaded, following the instructions 
in “Loading Paper” on page 1.11. Then you have to set the paper 
size and type using the operation panel buttons.

NOTE: These settings are applied to the stand-alone copy mode only. 
In PC printing mode, you have to select the paper type and size in the 
application program you use.

Paper Size

After loading paper, take the following steps to set the paper size 
from the operation panel:

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) until you see “3. COPY 
SETUP” and then press Enter. 

3 The first copy setup menu “PAPER SIZE” appears on the 
bottom line. Press Enter. 

The current setting is tagged with a  at the end of the 
display on the bottom line.

4 Press the Scroll buttons (  or ) until you see the paper 
size you are using in the display.

5 Press Enter to save the selection.

NOTE: When you use legal-size paper, do not pull out the paper 
output tray. If you do, a paper jam may occur.
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Paper Type

You can use special media such as inkjet, transparency, and photo 
paper as well as plain paper. After loading any special type of 
media, set the paper type using this menu:

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) until you see “3. COPY 
SETUP” and then press Enter. 

3 Press the Scroll buttons (  or ) until you see “PAPER 
TYPE” on the bottom line of the display.

4 Press Enter. The current setting is tagged with a  at the end 
of the display on the bottom line.

5 Press the Scroll buttons (  or ) until you see the paper 
type you are using in the display.

6 Press Enter to save the selection.

Loading the Original Documents

You can use the Automatic Document Feeder (ADF) or the 
document glass to load an original document for sending, copying 
and scanning. 

Your ADF can load up to 30 sheets at a time. When you load 
multipage documents of the same thickness and weight, you can 
use the ADF. 

If you want to load booklet, pamphlet, or documents having 
unusual characteristics, you have to use the document glass and 
load one sheet at a time. On the document glass, you can load the 
following types of documents:

• Thick paper
• Document with uneven surface
• Photographs
• Small documents (e.g. business cards, postcards)
• Special types of paper 
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Using Automatic Document Feeder (ADF)

1 Insert your document face up, with the top edge leading into 
the ADF. Adjust the document guides to the width of the 
document.

You can insert up to 30 sheets at a time.

2 Gently feed it in until “DOCUMENT READY” appears in the 
display.

Problem Documents

• To prevent document jams in the ADF, do not use any of the 
following:
- Wrinkled or creased paper
- Carbon paper or carbon-backed paper
- Curled or rolled paper
- Coated paper
- Torn paper
- Onion skin or thin paper

• Remove all staples, paper clips, or any other fasteners before 
loading the document into the ADF.

• Make sure any glue, ink, or correction fluid on the paper is 
completely dry before loading the document into the ADF.

• If you have a document that will not feed properly into the ADF, 
make a photocopy of the document and load the copy instead.

Document guide
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Using Document Glass

1 Open the document cover.

2 Place the document face down on the document glass. 
Position it so the horizontal and vertical edges are carefully 
aligned with the scales along the sides of the document 
glass.

3 Close the top cover slowly. Be careful not to move the 
document.

4 When you finish setting procedure for copying, sending, or 
scanning, the first page on the document glass is scanned, 
then the display shows “NEXT GO ON?” on the top line.

If you have next page, remove the scanned page and load 
the next page on the glass and press Enter. Repeat as 
necessary. When all pages are scanned, press Cancel/
Reset when the display shows “NEXT GO ON?.”

top corner of document
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If you want to copy or scan a book:

You can remove the top cover to place an original document such 
as a book. 

Lift the cover straight up to remove it.

NOTE: Be careful as the ADF plug on the cover is connected to the 
main body.

To insert the cover in place, hold it as shown and insert its hinges 
into the holes. Then close the top cover.
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Copying a Document

Follow these steps to copy using the operation panel:

1 Feed the document(s) to be copied face up into the ADF 
until “DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover.

For details on loading original document(s), see page 3.3.

2 Customise the copy settings including copy quality, contrast, 
number of copies, and copy size if necessary. See “Setting 
Copy Options” on page 3.8.

3 When you are finished setting the copy options, press Start 
Copy Black to begin a black and white copy, or press Start 
Copy Color for a colour copy.

NOTES: 
• You can set the user default copy settings which will apply when 

copying documents unless you change the settings for the 
individual copy job. See “Changing Default Settings” on page 
3.15.

• If an optional photo cartridge is installed in the product, you 
cannot use a black and white copy.

• If you want to cancel the copy job, press Cancel/Reset during 
copying.
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Setting Copy Options

The following buttons on the operation panel let you make all the 
basic settings: copy quality, contrast, number of copies and copy 
size.

NOTE: The option settings for the current copy job will be 
automatically reset to their default status (see 3.15) 2 minutes after 
the job is completed. If necessary, you can reset the copy option 
immediately by pressing Cancel/Reset.

Quality

To select the copy quality, use the Quality button on the operation 
panel. You can select BEST, NORMAL, or DRAFT. The BEST mode is 
good for documents with fine details. The copy quality is good but 
the copy speed is low. The NORMAL mode works well for normal 
documents (text). The DRAFT mode can be used for fast copying 
with lower resolution.

To select copy quality:

1 Press Quality. The current setting is tagged with a  at the 
end of the display. 

2 Scroll through the options available by pressing Quality 

repeatedly or using the Scroll buttons (  or ).

3 When the desired mode is displayed, press Enter to save the 
selection.

NOTES: 
• While the Paper Save mode is enabled, the print quality you 

selected through the Quality button is ignored and automatically 
applied to “NORMAL.”

• With an optional photo cartridge installed in the product, if you 
select the DRAFT setting, the display shows “LOAD BLACK INK” 
when you start copying and the product cannot print.
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Contrast

You can adjust the contrast for a document containing faint 
markings or dark images or photographs using the Contrast 
button. You can select LIGHTEN, DARKEN, PHOTO or NORMAL. The 
LIGHTEN contrast is good for documents containing dark images. 
The NORMAL contrast works well with a standard document. The 
DARKEN contrast works well with light print or faint pencil 
markings. Choose the PHOTO contrast if you are copying a 
photograph. 

To select the contrast:

1 Press Contrast. The current setting is tagged with a  at the 
end of the display on the bottom line. 

2 Scroll through the options available by pressing Contrast 

repeatedly or using the Scroll buttons (  or ). 

3 When the desired mode is displayed, press Enter to save the 
selection.

Copy page

You can select the number of copies, from 1 to 99. To change the 
number of copies:

1 Press Copy page.  

2 Enter the number of copies using the number keypad. Use a 
2-digit number.

3 When the desired quantity is displayed, press Enter to save 
the selection.

NOTE: If you load a document in the ADF, you cannot print multiple 
color copies. The product prints only 1 copy when you start color 
copying and the document is fed from the ADF. If you want to print 
multiple color copies, you must use the document glass.
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Zoom rate

You can reduce or enlarge the size of a copied image from 25% to 
400% using the Zoom Rate button on the operation panel. 

To select the zoom rate from pre-defined copy sizes:

1 Press Zoom Rate until the setting you want appears on the 
display.

2 Press Enter to save the selection. 

To fine-tune the size of copies:

1 Press Zoom Rate until you see “CUSTOM 100% (  )” on 
the display and then press Enter.

2 Enter the desired rate using the number keypad.

3 Press Enter to save the selection.

NOTES: 
• While the Paper Save mode is enabled, the zoom rate you 

selected is ignored.
• If you are copying from ADF, the zoom rate ranges from 25% to 100%.

Collating

When the Collate option is set to ON, your product sorts the copy 
job. For example, two copies of a three-page job will print one 
complete document followed by the second complete document 
(e.g. 1,2,3 then 1,2,3).

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) until you see “3.COPY 
SETUP” and then press Enter. 

3 Press the Scroll buttons (  or ) until you see “COLLATE” 
on the bottom line of the display.

4 Press Enter. The current setting is tagged with a  at the end 
of the display on the bottom line.

5 Press the Scroll buttons (  or ) to select “ON” or “OFF.” 
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6 If you selected “COLLATE ON”, the next display prompts you to 

select the print order. Press the Scroll button (  or ) to 
select “NORMAL” or “REVERSE”. If you selected “REVERSE”, the 
3 pages print in this order: 3, 2, 1.

7 Press Enter to save the selection.

NOTES: 
• Collation feature is available only when you make a black and white 

copy from ADF.
• If memory gets full while the product scans the documents, the 

collation feature will be automatically disabled and the product will 
not collate the copy outputs.

Using Special Copy 

You can use the following copy features using the Special Copy 
button on the operation panel:

• Fit to Page: Reduces or enlarges an image from 25% to 400% to 
fit onto a full page.

• Clone: Reduces or enlarges the copy image to fit to a selected 
frame size and then prints several copies of the image on the same 
page. You can also specify the number of images to be printed.

• Poster: Prints an image on multiple pages. Select 2x2 to print a 
4 page poster, 3x3 to print a 9 page poster or 4x4 to print a 16 
page poster. The image is automatically enlarged by up to 400% 
to fit onto the selected poster size.

• Mirror: Prints the reversed image of your original document. Use 
this feature to copy favourite photos or images onto Iron-on T-
shirt transfer and then iron the transfer sheet to make a custom 
T-shirts, banners, and flags. 

• Normal: Prints in normal mode.

NOTES: 
• The special copies are available only when you load document using 

the document glass. The special copies do not work with the ADF.
• When the Paper Save mode is enabled, any changes you made 

through these special copy features do not apply even though it 
seems to be accessible, and the print quality is applied to 
“NORMAL.”
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Fit to Page

1 Place a single document on the document glass face down 
then close the cover.

For details on loading an original document, see page 3.5.

2 Customise the copy settings including copy quality, contrast, 
and number of copies if necessary. See “Setting Copy Options” 
on page 3.8.

3 Press Special Copy. “FIT TO PAGE” appears on the bottom 
line of the display.

4 Press Enter.

5 Press Start Copy Black to begin black and white copying. 
To make a colour copy, press Start Copy Color.

NOTE: When the Fit to Page printing is enabled, the zoom rate you 
previously selected, if any, is ignored.

Clone

1 Place a single document on the document glass face down 
then close the cover.

For details on loading an original document, see page 3.5.

2 Customise the copy quality and contrast if necessary. See 
“Setting Copy Options” on page 3.8.

3 Press Special Copy.

4 Press the Scroll buttons (  or ) until you see “CLONE” on 
the bottom line of the display, then press Enter.

5 Press the Scroll buttons (  or ) until you see the desired 
frame size, then press Enter. 

6 Press Copy Page and enter the number of the image by using 
the number keypad and press Enter.

Download from Www.Somanuals.com. All Manuals Search And Download.



3.13Copy

7 Press Start Copy Black to begin black and white copying. To 
make a colour copy, press Start Copy Color.

NOTE: When making a clone, the zoom rate you previously selected, 
if any, is ignored.

Maximum number of images on one sheet of paper:

Poster

1 Place a single document on the document glass face down 
then close the cover.

For details on loading an original document, see page 3.5.

2 Customise the copy settings including copy quality, contrast, 
and number of copies if necessary. See “Setting Copy 
Options” on page 3.8.

3 Press Special Copy. 

Frame Size
Maximum Copies

Landscape Portrait

1.5 x 2” 16 12

2.5 x 3” 9 6

3.5 x 5” 4 3

4 x 6” 1 2

5 x 7” 1 2

8 x 10” 1 1

Portrait Landscape
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4 Press the Scroll buttons (  or ) until you see “POSTER” on 
the bottom line of the display, then press Enter.

5 Press the Scroll buttons (  or ) until you see the desired 
poster size on the display. The following options are available: 
2x2, 3x3, 4x4. 

6 Press Enter to save the selection.

7 Press Start Copy Black to begin black and white copying. To 
make a colour copy, press Start Copy Color.

NOTE: When printing a poster, the zoom rate you previously 
selected, if any, is ignored.

Mirror

1 Place a single document on the document glass face down 
then close the cover.

For details on loading an original document, see page 3.5.

2 Customise the copy settings including copy quality, contrast, 
number of copies, and zoom rate if necessary. See “Setting 
Copy Options” on page 3.8.

3 Press Special Copy.

4 Press the Scroll buttons (  or ) until you see “MIRROR” on 
the bottom line of the display, then press Enter.

5 Press Start Copy Black to begin black and white copying. 
To make a colour copy, press Start Copy Color.
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Changing Default Settings

The copy options including copy quality, contrast, number of copies 
and copy size can be set to the most frequently used modes. When 
a document is copied, the default settings will be activated unless 
otherwise changed by using the corresponding buttons on the 
operation panel.

To create your own default settings:

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press Enter. 

3 Press the Scroll buttons (  or ) until you see “SET 
DEFAULT” on the bottom line and then press Enter. 

With this menu, you can set the default contrast, quality, 
number of copies, and zoom rate which will be used in Copy 
mode. 

NOTE: Resolution setting is not applied to the Copy mode.

4 Press the Scroll buttons (  or ) to select the option menu 
and then press Enter.

5 Press the Scroll buttons (  or ) to select the settings you 
want to use as default. Use the number keypad to enter the 
default number of copies or set the custom zoom rate. 

6 Press Enter to save the selection.

7 Repeat as necessary.

NOTE: When you adjust copy settings or set special copy option, if 
you press Cancel/Reset, the settings are cancelled and return to 
their default status.
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Blocking Colour Copying

You can prevent unauthorized use of colour copying by requiring a 
special PIN (Personal Identification Number) to use colour copying.

Take the following steps to activate this feature and set the PIN:

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press Enter. 

3 Press the Scroll buttons (  or ) until you see “PIN CODE” 
on the bottom line of the display.

4 Press Enter. 

5 Press Scroll button (  or ) to select “ON” to activate this 
feature or “OFF” to disable this feature. 

6 If you selected “ON”, the next display prompts you to enter 
the PIN code number. Use the number keypad to enter the 
PIN. It is preset to 0000.

7 Press Enter to save the selection.

Note that you have to enter the PIN when the display prompts 
to activate colour copying .
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Scanning with the Samsung SCX-1150F lets you turn 
pictures and text into digital files on your computer. Then 
you can fax or e-mail the files, display them on your web 
site, or use them to create projects that you can print out 
using Samsung SmarThru software which came with your 
product.

This chapter includes:

•Scanning Basics

•Starting Scan from the Operation Panel

•Scanning Process with TWAIN-enabled Software
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Scanning Basics

Your SCX-1150F offers three ways to start scanning. These include:

• From the Samsung SmarThru software: Launch Samsung 
SmarThru and open the Scan Wizard to start scanning. Please 
refer to the SmarThru User’s Guide.

• From the operation panel on your product: Use the Scan to 
button on the operation panel to initiate scanning. SmarThru 
system launches automatically and the Scan Wizard window 
opens on the desktop window.

• From TWAIN-compliant software: You can use other software 
including Adobe PhotoDeluxe and Adobe Photoshop. 

NOTES: 
• To scan with your product, you must install the MFP driver.
• Scanning is through the same LPT or USB port which is currently 

assigned for your printer port.

Starting Scan from the Operation Panel

You can quickly start scanning from the operation panel on your 
product. The Samsung SmarThru program automatically launches 
and allows you to select the desired scan service. Take the following 
steps:

1 Make sure that your computer and SCX-1150F are turned on. 
You will see the scan monitor icon on the taskbar at the 
bottom right corner of the desktop window unless you disable 
or turn off the scan monitor.

Scan monitor
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2 Feed the document(s) to be copied face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover.

For details on loading original document(s), see page page 
3.3.

3 Press Scan to on the operation panel.

NOTE: If you press Scan to when the scan monitor on the desktop 
window is disabled or turned off (see page 4.2), “PC NOT AVAILABLE” 
appears on the display and you cannot achieve scanning.
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4 The Samsung SmarThru launches automatically and the Scan 
Wizard window opens.

The Scan Wizard lets you use the following services:

• Scan
Lets you scan the original documents and save them in the 
Image Manager of the Samsung SmarThru system. The 
Image Manager is an image database manager and image 
editor program. 

• Copy
Lets you use your product to produce professional quality 
copies. You can adjust the image size and make advanced 
settings.

• Scan to Email
Lets you scan the original document then launches a New 
Message form to send the just scanned image attached to a 
new mail. The email account must be configured in the 
Samsung SmarThru system to enable e-mail service. 

• Scan to FAX
Lets you scan the original documents then launches a New 
Fax form which helps you send them as a fax image.

• Scan to WEB
Lets you scan the original documents for further publishing 
to the Web.
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• Scan to OCR
Lets you scan the original documents and pass them to the 
OCR program. OCR (Optical Character Recognition) is the 
process of converting a scanned image into text that you 
can edit in a word processing program. After you scan your 
document, the software processes or “recognises” it. Then 
you can edit it and either save the file or open it in any 
word processing program on your computer.

5 Click the desired service.

6 The Samsung Scan Manager for the selected service opens. 
Adjust the scan settings. You can use the Help button to get 
on-line help. 

7 To start scanning, click Scan. 

For further information, please refer to the SmarThru User’s 
Guide which came with your product.

NOTE: If you want to cancel the scan job, press Cancel/Reset at 
any time.
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Scanning Process with TWAIN-enabled 
Software 

If you want to scan documents using another software, you will 
have to use TWAIN-compliant software such as Adobe PhotoDeluxe 
or Adobe Photoshop. The first time you scan with your SCX-1150F, 
you will need to select it as your TWAIN source on the application 
you will use. 

The basic scanning process involves a number of steps:

• Placing your photograph or page on the document glass.

• Opening an application (such as PhotoDeluxe or Photoshop).  

• Opening the TWAIN window and setting scan options.

• Scanning and saving your scanned image.

You have to follow the program’s instructions for acquiring an 
image. Please refer to the application user’s guide.
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5 FAX

This chapter includes:

•Sending a Fax

•Receiving a Fax

•Automatic Dialling

•Advanced Fax

•Additional Features
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Sending a Fax

Preparing Documents for Faxing

Use the following guidelines to prepare your documents for faxing:

• Do not attempt to feed the following types of documents into the 
Automatic Document Feeder:

- carbon-paper or carbon-backed paper
- coated paper
- onion skin or thin paper
- wrinkled or creased paper
- curled or rolled paper
- torn paper

• Remove all staples and paper clips before feeding the document.

• Make sure any glue, ink or correction fluid on the paper is 
completely dry before loading the document.

• Do not load documents containing different sizes or weights of 
paper.

Acceptable Documents (for ADF*)

Single Sheet 2 or More Sheets

Document Size
Max. 8.5 in. (W) x 14 in. (L)

(216 mm x 356 mm)
8.5 in. (W) x 11.7 in. (L)

(216 mm x 297 mm)

Min. 5.8 in. (W) x 5.0 in. (L) (148 mm x 128 mm)

Effective Scanning Width 8.26 in. (210 mm)

Number of sheets which can be 
loaded at a time Up to 30

Thickness of document 0.05 mm ~ 0.07 mm
0.15 mm ~ 0.2 mm 0.075 mm ~ 0.12 mm

Print Quality Uncoated on both sides

*ADF stands for Automatic Document Feeder. It allows you to stack original documents,
which will be faxed or copied one by one.
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Loading Document(s) 

You can use the Automatic Document Feeder (ADF) or the 
document glass to load an original document for faxing. Your ADF 
can load up to 30 sheets at a time. Using the document glass, you 
can load one sheet at a time. 

1 Feed the document(s) face up, with the top edge leading into 
the ADF. Adjust the document guides to the width of the 
document. Then gently feed it in until “DOCUMENT READY” 
appears in the display.

Or 

Place a single document on the document glass face down 
then close the cover.

2 If necessary, use the Resolution and the Contrast buttons 
to adjust the quality of your faxes. For details, see page 5.4.

Document guide
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Adjusting Quality of Your Fax

When setting typical text based documents, your product enables 
you to send documents that are very close to the quality of the 
original.

However, if you send documents that are of poor quality, or contain 
photographs, you can adjust the following features to best suit the 
document.

NOTE: After you adjust the resolution or the contrast, if no key is 
pressed for 2 minutes or if you press Cancel/Reset, the settings are 
automatically reset to their default status (see page page 5.6). 

Setting Resolution

Resolution is a measure of the fineness or clarity of a printout. Low 
resolutions may cause text and graphics to have a jagged 
appearance, while higher resolutions provide smoother curves and 
lines, crisp text and graphics, and a better match to traditional 
typeface designs.

1 Press Resolution on the operation panel to select the 
resolution setting. The default setting appears on the bottom 
line of the display.

2 To change the setting, press Resolution or use the Scroll 

buttons (  or ). You can choose between STANDARD, FINE, 
and SUPERFINE. Press Enter to save the selection.

The document types recommended for quality settings are 
described below.

STANDARD works well for normal handwritten typed, or 
printed documents.

FINE is good for documents containing a lot of detail.

SUPERFINE works well for documents containing extremely 
fine detail. Superfine works only if the remote machine also 
has the SUPERFINE feature.
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NOTES: 
• The SUPERFINE resolution is not activated when the document is 

required to pre-scan into memory before sending, for example, 
when the SEND FROM MEMORY feature is set to ON (see page 
5.42) or when you use the advanced faxing (see page 5.28). The 
SUPERFINE resolution is automatically converted to the FINE 
resolution when the document is scanned into memory.

• If the product is set to the SUPERFINE resolution and the remote 
fax machine does not support the SUPERFINE resolution, your 
product will transmit using the highest resolution mode supported 
by the remote fax machine.

Setting Contrast

Contrast is the difference in brightness between the lightest and 
darkest parts of a printed document. You can adjust the contrast 
your product will use to send faxes. Adjust according to how light 
or dark your document is.

1 Press Contrast on the operation panel to select the contrast 
setting. The default setting appears on the bottom line of the 
display.

2 To change the setting, press Contrast or use the Scroll 

buttons (  or ). Press Enter to save the selection.

You can choose between LIGHTEN, PHOTO, DARKEN, or 
NORMAL.

LIGHTEN works well with dark print.

PHOTO is used when faxing photographs or other 
documents containing shades of grey. 

DARKEN works well with light print or faint pencil markings. 
The light image and text on the original document will be 
darker on the printed page.

NORMAL works well with standard typed or printed 
documents. 
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Setting Default Resolution and Contrast

You can set the default contrast and resolution for outgoing faxes. 
The default setting is normally applied to items being faxed. 

If you want to use other Resolution and Contrast settings, you can 
only change the resolution and contrast for the fax job you are 
currently sending by pressing the Resolution or the Contrast 
button on the operation panel. 

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press Enter.

3 Press the Scroll buttons (  or ) until you see “SET 
DEFAULT” on the bottom line and then press Enter. The first 
default setting menu “CONTRAST” appears on the bottom line.

4 Press Enter. The current setting displays on the bottom line.

5 Press the Scroll buttons (  or ) to select the setting you 
want to use as default and then press Enter. 

6 Press the Scroll buttons (  or ) until you see 
“RESOLUTION” on the bottom line and then press Enter. The 
current setting displays on the bottom line.

7 Press the Scroll buttons (  or ) to select the setting you 
want to use as default. 

8 Press Enter to save the selection.

9 To return to Standby mode, press Cancel/Reset.

NOTE: Quality, Copy Page, Zoom Rate settings are not applied to the 
Fax mode. These settings are available for the Copy mode only. 
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Sending a Fax Automatically

1 Feed the document(s) to be faxed face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover. For details on loading original 
documents, see page page 3.3.

2 You can adjust the resolution and the contrast to suit your 
fax needs. For details, see “Adjusting Quality of Your Fax” on 
page page 5.4.

3 Enter the number of the remote fax machine using the 
number keypad. 

If you make a mistake while entering a number, move the 
cursor under the wrong digit by using the Scroll buttons (  
or ), and correct the number or press Search/Delete to 
delete the number.

4 To send faxes in black and white, press Start FAX Black. 

To send faxes in colour to the fax machines with colour 
capability, press Start FAX Color.

5 If the SEND FROM MEMORY feature is set to ON (default 
setting), the document is scanned into memory and the 
display shows the memory capacity and the number of pages 
being stored in memory.

If the document is fed from the document glass, the display 
shows “NEXT GO ON?” on the top line after the document is 
scanned into the memory. If you have the next page, remove 
the scanned page and load the next page on the glass and 
press Enter. Repeat as necessary. 

When all pages are scanned, press Cancel/Reset when the 
display shows “NEXT GO ON?.”

6 The number is dialled then begins transmission when the 
remote fax machine is ready.

NOTE: If you want to cancel the fax, press Cancel/Reset at any 
time during the transmission.
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Confirming a Transmission

When the last document has been sent successfully, the product 
beeps and returns to Standby mode.

If something went wrong during your fax transmission, an error 
message appears on the display. For a listing of error messages and 
their meanings, see page 7.7. When you receive an error message, 
press Cancel/Reset to clear the message and resend the 
document. 

You can print out a confirmation report automatically each time 
sending is completed. For more information, see “Fax Setup 
Options” on page 5.41.

Automatic Redial

When you send a fax in black and white, if the number you have 
dialled is busy or there is no answer, the product will automatically 
redial the number every three minutes up to a maximum of five 
times. Automatic redial is not available for colour fax.

This display shows “RETRY REDIAL?.” To redial the number without 
waiting, press Enter. To cancel the automatic redial, press Cancel/
Reset.
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Sending a Fax Manually

Manual sending allows you to talk to the other party before sending 
the document. This method is useful if the other party must 
manually set their fax machine to receive before they can receive 
a fax. For this mode, you need to have a telephone connected to 
your product (see page page 1.8).

1 Feed the document(s) to be faxed face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover. For details on loading original 
document(s), see page page 3.3.

2 You can adjust the resolution and the contrast to suit your fax 
needs. For details, see page page 5.4.

3 Make a call to the remote fax machine from the extension 
telephone connected to your SCX-1150F. 

4 When you hear the other party answers the call, start talking.

When you hear the high-pitched fax signal of the other party’s 
fax machine, press Start FAX Black for black and white 
faxing or Start FAX Color for colour faxing.

Hang up the telephone.

NOTES: 
• If you want to cancel the fax, press Cancel/Reset at any time 

during the transmission.
• You can use the OHD button on the operation panel to engage the 

telephone line and dial the number of the remote fax machine. 
When you hear the fax signal, press Start FAX Black or Start 
FAX Color to start sending. If you pressed the OHD button, you 
will hear the other party’s voice but you will not be able to talk 
even by using the extension telephone connected to your product.
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Redial

The memory in your product retains the last 10 numbers called, 
and the last 30 numbers received, provided the CLI (Caller Line 
Identification) service is available.

NOTE: The CLI service may be unavailable depending on your area or 
country.

To redial the number last called:

1 Press Redial/Pause with a document loaded in the ADF or on 
the document glass. The display shows the last number dialled 
and prompts you to “PRESS FAX BLACK OR COLOR.” 

2 Press Start FAX Black for black and white faxing or Start 
FAX Color for colour faxing. Your product begins to send the 
number last called.

To view and dial any of the last numbers called:

1 Press and hold Redial/Pause for about 2 seconds. The 
display shows “REDIAL” on the bottom line.

2 Press Enter. The display shows the last number you called. 

3 Press the Scroll buttons (  or ) to search through the 
memory until you see the number you want to dial.

If you have dialled the same number multiple times, the 
product does not count the duplicates.

4 When the number appears on the display, press Start FAX 
Black for black and white faxing or Start FAX Color for 
colour faxing.
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To view and dial any of the last numbers you received:

1 Press and hold Redial/Pause for 2 seconds. The display 
shows “REDIAL” on the bottom line.

2 Press Enter.

3 Press the Scroll buttons (  or ) to select “CALLER ID” and 
then press Enter.

4 Press the Scroll buttons (  or ) to search through the 
memory until you see the number you want to dial.

5 When the number appears on the display, press Start FAX 
Black for black and white faxing or Start FAX Color for 
colour faxing.

Using Toll Save Transmission

If you have set a specific toll save time using the FAX SETUP 
menu (see page page 5.41), you can quickly set your document(s) 
to be sent at the preset time using the SAVE Toll button on the 
operation panel. Using this feature, you can take advantage of 
lower long distance rates at night, for example.

1 Feed the document(s) to be faxed face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover. For details on loading original 
document(s), see page page 3.3.

2 You can adjust the resolution and the contrast to suit your 
fax needs. For details, see page page 5.4.
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3 Press SAVE Toll. The display prompts you to enter the fax 
number.

4 Enter the number of the remote fax machine using the 
number keypad. 

You can also use a one-touch dial button or press Speed then 
use a 2-digit speed dial number.

5 When the number appears correctly, press Enter. The display 
asks you to enter another fax number to send the document.

6 If you want to send to more than one location, select “1:YES” 
and enter another fax number using the number keypad.

7 When the number appears correctly on display, press Enter.

Or

To send to one location or when you complete the last fax 
number setting, select “2:NO” in the ANOTHER FAX NO.? 
screen.

8 The document is scanned into memory.

If the document is fed from the document glass, the display 
shows “NEXT GO ON?” on the top line after the document is 
scanned into the memory. If you have the next page, remove 
the scanned page and load the next page on the glass and 
press Enter. Repeat as necessary. 

When all pages are scanned, press Cancel/Reset when the 
display shows “NEXT GO ON?.” The display shows a reminder 
that a toll save transmission is reserved at the preset time.

NOTE: To cancel the job reserved in memory, see “Cancelling a 
Scheduled Operation” on page 5.38.

Transmission will start at 11:45 PM.
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Receiving a Fax

NOTE: If you installed a photo cartridge in your product, the received 
faxes will not print out. The display shows “MEMORY RECEIVED” and 
“LOAD BLACK INK” alternatively. Replace the photo cartridge with a 
black cartridge for receiving faxes.

About Reception Modes

Your product has four reception modes:

• In FAX mode, the product answers an incoming call and 
immediately goes into receive mode. 

• In ANS/FAX mode, the answering machine answers an incoming 
call, and the caller can leave a message on the answering 
machine. If the product senses a fax tone on the line, the call 
automatically switches to the product. 

NOTE: To use the ANS/FAX mode, attach an answering machine to 
the EXT jack on the back of your product (see page page 1.8). 

• In TEL mode, the automatic fax reception is turned off. You can 
receive a fax by picking up the handset of the extension phone 
and pressing  9  on the phone. 

You can also set the product to receive a fax by pressing OHD 
then any of the Start FAX button on the operation panel.

NOTE: To use the TEL mode, connect an extension phone to the EXT 
jack on the back of the product.
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• In DRPD mode, you can receive a call using the Distinctive Ring 
Pattern Detection (DRPD) feature. “Distinctive Ring” is a 
telephone company service which enables a user to use a single 
telephone line to answer several different telephone numbers. 
This mode is displayed when you have set up the distinctive ring 
pattern. For details on this feature, see page page 5.44.

The current reception mode is displayed when your product is in 
Standby mode. 

If you seldom use the fax line for voice conversations, set your 
product to receive a fax automatically by selecting the FAX mode.

 

Loading Paper for Receiving Faxes 

The instructions for loading paper in the paper bin are the same 
whether you are printing, faxing, or copying, except that faxes can 
only be printed on letter-, A4-, or legal-sized paper. See “Loading 
Paper” on page page 1.11 for instructions.

After loading paper for receiving faxes, set the paper size to the 
size of paper you normally load in the paper bin. Your product uses 
this setting when printing reports and determining auto reduction 
for incoming faxes. See page page 5.42 to set the paper size.

NOTE: The FAX PAPER SIZE setting does not affect the printing 
from PC. If you are loading special-sized media only for your current 
print job, do not change this setting. After you have finished printing, 
just reload the original paper for fax printing.

Current reception mode
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Receiving Automatically in FAX Mode 

Your product is preset to FAX mode at the factory. If you have 
changed the fax mode, take the following steps to receive faxes 
automatically:

1 Press Receive Mode until you see “FAX” on the bottom line. 
Then press Enter.

2 When you receive a call, the product answers the call on a 
specified number of rings and receives a fax automatically. To 
change the number of rings. See “Fax Setup Options” on page 
page 5.41.

To adjust the ringer volume, see “Setting Sounds” on page 
page 1.41.

Receiving Automatically in ANS/FAX 
Mode 

For this mode, you must attach an answering machine to the EXT 
jack on the back of your product (see page page 1.8). 

1 Press Receive Mode until you see “ANS/FAX” on the bottom 
line. Then press Enter.

2 When you receive a call, the answering machine will answer. 

If the caller leaves a message, the answering machine stores 
the message as it would normally. If your product hears a fax 
tone on the line, it automatically starts to receive fax.
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NOTES:  
• If you have set your product to ANS/FAX mode and your answering 

machine is switched off, or no answering machine is connected to 
your product, your product will automatically go into FAX mode 
after 10* rings. 

• If your answering machine has a ‘user-selectable ring counter’, set 
your product to answer incoming calls within 1 ring. 

• If you are in TEL mode (manual reception) when the answering 
machine is connected to your product, you must switch off the 
answering machine, or the outgoing message from the answering 
machine will interrupt your phone conversation. 

* This switching interval from ANS/FAX to FAX varies by country regulations.
For example, it is 10 rings in UK, and 6 for most of other countries.

Receiving Manually in TEL Mode Using 
an Extension Phone

If you are using the external telephone connected to the EXT jack 
on your product, you can answer calls and start the product to 
receive a fax.

1 Press Receive Mode until you see “TEL” on the bottom line. 
Then press Enter.

2 When the telephone rings, answer it by picking up the handset 
of the external phone.

3 If you hear a fax tone, or if the person on the other end asks 

you to receive a fax, press the keys “  9 ” (star nine star) 
on the extension telephone. 

If you still hear the fax tone from the remote machine, try 
pressing “  9 ” once again.

“  9 ” is the remote receive start code preset at the 
factory. The first and the last asterisks are fixed, but you can 
change the middle number to whatever you choose. For more 
information, see page page 5.44.

4 When the product starts receiving the document, replace the 
handset of the extension telephone.

Download from Www.Somanuals.com. All Manuals Search And Download.



5.17FAX

Receiving Using DRPD Feature

You can not set DRPD (Distinctive Ring Pattern Detection) as the 
receive mode using the Receive Mode button on the operation 
panel if you have not set up your product for use with the DRPD 
service and turned on the feature (see page page 5.44). 

When the receive mode is set to DRPD, if someone calls using the 
number assigned for telephone communication, your product rings 
in the pattern you registered for voice calls. When you hear this 
pattern, simply pick up the handset of  the extension telephone 
connected to your product and talk. 

When someone sends a fax using the number assigned for fax 
communication, your product receives the fax automatically.

You can select the other receive mode using the Receive Mode 
button on the operation panel to temporarily disable the DRPD 
service.

Receiving in Colour

Your product has been set to receive faxes in colour from fax 
machines with colour capability. When receiving a fax, your product 
detects if the incoming fax is in colour or black & white, and prints 
the fax accordingly.

Receiving Fax in Memory

Since your product is a multitasking device, it can receive faxes 
while you are making copies or printing. If you receive a fax while 
you are copying or printing, your product stores the incoming fax 
in memory. Then, as soon as you finish copying or printing, the 
product automatically prints the fax. 

If the product encounters a problem when it is receiving a fax, the 
product also stores the unprinted pages of the fax in memory.
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Using Fax Forwarding

You can set your product to forward incoming faxes to another fax 
number during a specified time period. When the fax arrives at your 
product, it is stored in memory. Then, your product dials the fax 
number you have specified and sends the fax.

If it cannot forward a fax after repeated attempts because of an 
error, such as the number being busy and redials failed, your 
product will print the fax. If it runs out of memory while receiving 
a fax, it will terminate the incoming fax and only forward the partial 
pages already stored in memory.

You can also select the fax forwarding option which allows you to 
print the fax on your product if fax forwarding is completed without 
an error.

 

To use fax forwarding, take the following steps:

1 Press FAX Forward. 

2 Select the fax forwarding option by pressing FAX Forward or 

the Scroll buttons (  or ). The following options are 
available:

FORWARD: forwards the fax to a specified number. Your 
product does not print the fax.

FORWARD&PRINT: forwards the fax to a specified number 
and prints the fax on your product.

OFF: turns the fax forwarding off.

3 Press Enter to save the selection.

4 If you choose to forward faxes, enter the fax number where 
you would like the fax to go, and then press Enter to save 
your selection.

5 Enter the date using the number keypad you want to start 
forwarding incoming faxes and then press Enter.
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6 Enter the time using the number keypad you want to start 
forwarding incoming faxes and then press Enter.

7 Enter the date using the number keypad you want to end 
forwarding incoming faxes and then press Enter.

8 Enter the time using the number keypad you want to end 
forwarding incoming faxes and then press Enter.

9 The display shows “FW” at the left side of the receiving mode, 
for example “FW FAX”, at the bottom right corner to indicate 
that fax forwarding feature is activated. 

When the time you have set to start forwarding is up, the 
display shows “FORWARDING.” After the forwarding is 
completed, the sending confirmation report prints out 
automatically.

NOTE: If the fax is received in color, the product converts color fax 
to black&white and forwards the converted black&white fax to a 
specified destination.
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Automatic Dialling

One-touch Dialling

One-touch dialling lets you use any of the 10 one-touch buttons to 
automatically dial a number. 

Storing a Number for One-touch Dialling

1 Press and hold one of ten one-touch buttons for about 2 
seconds. The display shows “Txx:,” where xx represents the 
selected one-touch button number.

If a number is already stored in the location you chose, the 
display shows the number. To replace the number with other 
phone number, select “1:RENEW”. Otherwise, select 
“2:OTHER” to select other one-touch dial location.

2 Enter the number you want to store by using the number 
keypad and then press Enter.

To insert a pause between numbers, press Redial/Pause. “P” 
appears on the display.

If you make a mistake while entering a number, press 
Search/Delete and re-enter the correct number.

3 To assign a name to the number, enter the desired name. For 
information on how to enter names, see “How To Enter 
Characters Using the Number Keypad” on page page 1.37.

Or, 

If you do not want to assign a name, skip this step.

4 Press Enter when the name appears correctly or simply 
without entering a name.
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5 To store more telephone numbers, press another one-touch 
button and repeat steps 2 through 4.

Or

To return to Standby mode, press Cancel/Reset.

Sending a Fax using a One-touch Number

1 Feed the document(s) to be faxed face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover. For details on loading original 
document(s), see page page 3.3.

2 You can adjust the resolution and the contrast to suit your fax 
needs. For details, see page page 5.4.

3 Press the one-touch button where you stored a number on the 
operation panel. The display shows “PRESS FAX BLACK OR 
COLOR” then the fax number stored in the one-touch dial 
location alternatively.

4 Press Start FAX Black for black and white faxing or Start 
FAX Color for colour faxing.
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Speed Dialling

You can store up to 90 numbers in 2-digit Speed Dial locations (01-
90). 

Storing a Number for Speed Dialling

1 Press and hold Speed on the operation panel for 2 seconds. 

2 Enter a speed dial number using the number keypad and then 
press Enter.

If a number is already stored in the location you chose, the 
display shows the number. To replace the number with 
another phone number, select “1:RENEW.” Otherwise, select 
“2:OTHER” to select another speed dial location.

3 Enter the number you want to store, and press Enter.

4 To assign a name to the number, enter the desired name. For 
details on how to enter names, see “How To Enter Characters 
Using the Number Keypad” on page page 1.37.

Or

If you do not want to assign a name, skip this step. 

5 Press Enter when the name appears correctly or simply 
without entering a name. 

6 To store more telephone numbers, repeat steps 2 through 5. 

Or

To return to Standby mode, press Cancel/Reset. 
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Sending a Fax using a Speed Number

1 Feed the document(s) to be faxed face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover. For details on loading original 
document(s), see page page 3.3.

2 You can adjust the resolution and the contrast to suit your fax 
needs. For details, see page page 5.4.

3 Press Speed on the operation panel.

4 Enter the speed dial number using the number keypad.

You can scroll through the numbers stored in memory by 
pressing the Scroll buttons (  or ).

5 When the desired number appears in the display, press Enter. 
The display shows “PRESS FAX BLACK OR COLOR.”

6 Press Start FAX Black for black and white faxing or Start 
FAX Color for colour faxing.
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Group Dialling

If you frequently send the same document to several destinations, 
you can create a group of these destinations and set them under a 
one-touch button. This enables you to press a single one-touch 
button to send the same document to all the destinations in the 
group.

NOTE: You can only group numbers that have already been 
registered for speed dialling.

Setting Group Dial

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) until you see “6.GROUP 
SETUP” and then press Enter. The display prompts you to 
select a one-touch button.

3 Press the one-touch button under which you want to register 
the group and then press Enter.

NOTE: If the one-touch button has already been registered for one-
touch dialling or another group, the display prompts you to renew the 
selected one-touch button or select another one-touch button. Select 
“1:RENEW” to delete the contents in the selected one-touch button 
and continue, or “2:OTHER” to keep the contents and start over with a 
different one-touch button.

4 The selected group number appears in the display and the 
display prompts you to confirm the number. Press Enter to 
accept “1:YES.” If you select “2:NO”, the selected one-touch 
button will be cancelled and you can start over with another 
one-touch group number.

5 The display prompts you to enter a speed dial number. Enter 
the 2-digit speed dial number you want to include in the group 
and then press Enter.
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6 Repeat step 5 to enter another speed dial number into the 
group.

7 When you have entered all the desired numbers, press 
Cancel/Reset. The display prompts you to enter a name.

8 If you want to assign a name to the group, enter the desired 
name. Or, skip this step.

9 Press Enter after you enter the name or without entering the 
name.

10 If you want to assign another group, repeat from step 3.

To return to Standby mode, press Cancel/Reset. 

Sending a Fax Using Group Dialling 
(Multi-Address Transmission)

You can use Group Dialling for broadcasting, delayed fax, priority 
fax, or toll save transmission.

Follow the procedure of the desired operation (Broadcasting - page 
page 5.28, Delayed Fax - page page 5.30, Toll Save transmission - 
page page 5.11). When you come to a step in which the display 
requests you to enter the remote fax number, press the one-touch 
button assigned to a group. You can use only one group number for 
one operation. Then continue the procedure to complete the 
desired operation. 

Your product automatically scans the document loaded in the ADF 
or the document glass into the memory, and the product will dial 
each of the numbers included in the Group. 

NOTE: If you use group dialling, only black and white faxing is 
available.
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Searching for a Number in the Memory 

There are two ways to search for a number in the memory. You can 
either scan from A to Z sequentially, or you can search using the 
first letter of the name associated with the number. 

Searching Sequentially through the Memory

1 Press Search/Delete on the operation.

2 Press the Scroll buttons (  or ) to scroll through the 
memory until you find the name and number you want. 

Pressing the Scroll buttons (  or ) allows you to search 
downward through the entire memory in alphabetical order 
(from A to Z).

While searching through the product’s memory, you will see 
that each entry is preceded by one of three letters: T for one-
touch dial, S for speed, or G for group dial number. These 
letters tell you how the number is stored. 

3 When the name and number you want appears on the display, 
press Enter. The display shows “PRESS FAX BLACK OR 
COLOR.”

4 Press Start FAX Black for black and white faxing or Start 
FAX Color for colour faxing.
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Searching with a Particular First Letter

1 Press Search/Delete, then press the button labelled with the 
letter you want to search for. A name beginning with the letter 
appears on the display.

For example, if you want to find the name MOBILE, press the 
6 button, which is labelled with MNO.

2 Press the Scroll buttons (  or ) to display the next name 
in the list.

3 When the name and number you want appear, press Enter. 
The display shows “PRESS FAX BLACK OR COLOR.”

4 Press Start FAX Black for black and white faxing or Start 
FAX Color for colour faxing.
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Advanced Fax

NOTES: 
• You cannot use a colour fax for all advanced fax features.
• When you select resolution for advanced faxes, do not select 

SUPERFINE resolution. Even though you select SUPERFINE, the 
documents will be sent with the FINE resolution. 

Broadcasting

Documents are automatically stored in memory in the black and 
white mode and sent to a remote station. Use this feature to send 
your documents to multiple locations. After sending, the 
documents are automatically erased from the memory. 

1 Feed the document(s) to be faxed face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover. For details on loading original 
document(s), see page page 3.3.

2 You can adjust the resolution and the contrast to suit your fax 
needs. For details, see page page 5.4.

3 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

4 Press the Scroll buttons (  or ) until you see 
“4.ADVANCED FAX” and then press Enter. The display shows 
the first advanced fax feature “BROADCASTING” on the 
bottom line.

5 Press Enter to access the BROADCASTING menu.
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6 Enter the number of the remote fax machine using the 
number keypad.

You can also press a one-touch button including group dial 
buttons, or press Speed, and enter a 2-digit speed dial 
number. The stored number appears on the display.

7 Press Enter to confirm the number. The display asks you to 
enter another fax number to send the document.

8 Select “1:YES” and enter another fax number using the 
number keypad. 

You can also press a one-touch button, or press Speed and 
enter a speed dial number. Note that you cannot use Group 
dial numbers for another fax number.

9 The number appears on the display. Press Enter to confirm 
the number.

Or

To send to one location or when you complete the last fax 
number setting, select “2:NO” in the ANOTHER FAX NO.? 
screen.

10 The document will be scanned into the memory before 
transmission. The display shows the memory capacity and the 
number of pages being stored in the memory. 

If the document is fed from the document glass, the display 
shows “NEXT GO ON?” on the top line after the document is 
scanned into the memory. If you have the next page, remove 
the scanned page and load the next page on the glass and 
press Enter. Repeat as necessary.

When all pages are scanned, press Cancel/Reset when the 
display shows “NEXT GO ON?.”

11 The product begins sending the document in order of the 
numbers you entered.
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Delayed Fax

You can set your product to send a fax at a later time when you will 
not be present. 

NOTE: You cannot use the colour fax for the delayed faxing.

1 Feed the document(s) to be faxed face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover. For details on loading original 
document(s), see page page 3.3.

2 You can adjust the resolution and the contrast to suit your fax 
needs. For details, see page page 5.4.

3 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

4 Press the Scroll buttons (  or ) until you see 
“4.ADVANCED FAX” and then press Enter. The display shows 
the first advanced fax feature “BROADCASTING” on the 
bottom line.

5 Press the Scroll buttons (  or ) until you see “DELAYED 
FAX” on the bottom line and then press Enter.

6 Enter the number of the remote fax machine using the 
number keypad.

You can also press a one-touch button including group dial 
buttons, or press Speed, and enter a 2-digit speed dial 
number. The stored number appears on the display.

7 Press Enter to confirm the number. The display asks you to 
enter another fax number to send the document.
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8 If you want to send to more than one location, select “1:YES”, 
and enter another fax number using the number keypad. 

You can also press a one-touch button, or press Speed and 
enter a speed dial number. Note that you cannot use Group 
dial numbers for another fax number.

9 The number appears on the display. Press Enter to confirm 
the number.

Or

To send to one location or when you complete the last fax 
number setting, select “2:NO” in the ANOTHER FAX NO.? 
screen.

10 The display asks you to enter a name. If you want to assign a 
name to the transmission, enter the name. If not, skip over 
this step.

For details on how to enter the name using the number 
keypad, see “How To Enter Characters Using the Number 
Keypad” on page page 1.37.

11 Press Enter. The display shows the current time and asks you 
to enter the start time when the fax is to be sent. 

12 Enter the time by using the number keypad.

To select AM or PM for 12-hour format, press the Scroll 
buttons (  or ). If you set a time earlier than the current 
time, the document will be sent at that time on the following 
day. 

13 Press Enter when the start time on the display is correct.

The document will be scanned into the memory in the black 
and white mode before transmission. 

The display shows the memory capacity and the number of 
pages being stored in the memory.

Download from Www.Somanuals.com. All Manuals Search And Download.



5.32 FAX

14 If the document is fed from the document glass, the 
display shows “NEXT GO ON?” on the top line after the 
document is scanned into the memory. If you have the 
next page, remove the scanned page and load the next 
page on the glass and press Enter. Repeat as necessary.

When all pages are scanned, press Cancel/Reset when the 
display shows “NEXT GO ON?.”

The product returns to Standby mode and the display reminds 
you that you are in Standby mode and that Delayed 
Transmission is set.

NOTE: If you want to cancel the Delayed Fax, see “Cancelling a 
Scheduled Operation” on page 5.38.

Priority Fax

When the Priority Send is enabled, a high priority document can be 
transmitted ahead of reserved operations. The document is 
scanned into the memory, then transmitted when the current 
operation is concluded. In addition, the Priority Send will interrupt 
a broadcast operation between stations (i.e., when transmission to 
station A ends, before transmission to station B begins) or between 
redial attempts.

NOTE: You cannot use the colour fax for the priority faxing.
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1 Feed the document(s) to be faxed face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover. For details on loading original 
document(s), see page page 3.3.

2 You can adjust the resolution and the contrast to suit your fax 
needs. For details, see page page 5.4.

3 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

4 Press the Scroll buttons (  or ) until you see 
“4.ADVANCED FAX” and then press Enter. The display shows 
the first advanced fax feature “BROADCASTING” on the 
bottom line.

5 Press the Scroll buttons (  or ) until you see “PRIORITY 
FAX” on the bottom line and then press Enter.

6 Enter the number of the remote fax machine using the 
number keypad.

You can also press a one-touch button, or press Speed, enter 
a 2-digit speed dial number. The stored number appears on 
the display.

NOTE: You cannot use group dial numbers for the priority faxing.

7 Press Enter to confirm the number. The display asks you to 
enter a name. 

8 If you want to assign a name to the transmission, enter the 
name. If not, skip over this step.

For details on how to enter a name using the number keypad, 
see “How To Enter Characters Using the Number Keypad” on 
page page 1.37.
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9 Press Enter. The document will be scanned into the memory 
before transmission. 

The display shows the memory capacity and the number of 
pages being stored in the memory in the black and white 
mode.

If the document is fed from the document glass, the display 
shows “NEXT GO ON?” on the top line after the document is 
scanned into the memory. If you have the next page, remove 
the scanned page and load the next page on the glass and 
press Enter. Repeat as necessary.

When all pages are scanned, press Cancel/Reset when the 
display shows “NEXT GO ON?.”

10 The product shows the number being dialled and then begins 
sending the document.

Polling

Polling is used when one fax machine requests another to send a 
document. This is useful when the person with the original 
document to be sent is not in the office. The person who wants to 
receive the document calls the machine holding the original and 
requests that the document be sent. In other words, it “polls” the 
machine holding the original.

Polling Transmission

You can program your product to send documents in your absence 
when polled by a remote fax machine. It is possible to use a poll 
code to prevent unauthorised polling of your product. When you 
secure your product in this manner, only those who know the poll 
code can poll your product.
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1 Feed the document(s) to be faxed face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover. For details on loading original 
document(s), see page page 3.3.

2 You can adjust the resolution and the contrast to suit your fax 
needs. For details, see page page 5.4.

3 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

4 Press the Scroll buttons (  or ) until you see 
“4.ADVANCED FAX” and then press Enter. The display shows 
the first advanced fax feature “BROADCASTING” on the 
bottom line.

5 Press the Scroll buttons (  or ) until you find “SEND 
POLLING” on the bottom line and then press Enter. 

The display asks you to enter a 4-digit poll code. The poll code 
is preset to 0000 at the factory, which represents no poll 
code.

6 If you want to use a poll code, enter the desired 4-digit code 
(except for 0000) and then press Enter. 

Or

If you do not want to secure the transmission with a poll code, 
press Enter when the display shows “0000” for the poll code, 
or enter 0000.

7 The product stores the document in the memory. 

The display counts the number of pages being stored in the 
memory and the memory capacity remaining.

If the document is fed from the document glass, the display 
shows “NEXT GO ON?” on the top line after the document is 
scanned into the memory. If you have the next page, remove 
the scanned page and load the next page on the glass and 
press Enter. Repeat as necessary.
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When all pages are scanned, press Cancel/Reset when the 
display shows “NEXT GO ON?.”

8 The product returns to Standby mode and the display shows a 
reminder that TX Poll is set. 

NOTE: If you have previously set the receive mode to other than FAX 
mode, the product automatically switches to FAX mode (automatic 
receiving) when set to be polled.

Polling a Remote Machine

Your product polls a remote fax machine and retrieves a document, 
which is stored in memory and then prints. The method lets you 
perform polling reception when telephone-line rates are at their 
lowest.

1 Press OHD and enter the number of the remote machine.

2 When you hear a fax tone from the remote machine, press 
Setup. The display shows “TO RX ROLL PRESS ENTER.”

3 Press Enter. The display asks you to enter a 4-digit poll code. 
Poll code is preset to 0000 at factory. 0000 represents no 
code.

4 If the remote machine is secured with a Poll code, you must 
enter the correct code and then press Enter.

Or

If the remote machine is not secured with a Poll code, just 
press Enter to accept “0000” which represents on code.

5 Your product starts to receive the document from the remote 
machine.
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Adding Documents To a Scheduled 
Operation

You can add documents to the delayed transmission previously 
reserved in your product’s memory.

1 Feed the document(s) to be faxed face up into the ADF until 
“DOCUMENT READY” appears in the display.

Or

Place a single document on the document glass face down 
then close the cover. For details on loading original 
document(s), see page page 3.3.

2 You can adjust the resolution and the contrast to suit your fax 
needs. For details, see page page 5.4.

3 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

4 Press the Scroll buttons (  or ) until you see 
“4.ADVANCED FAX” and then press Enter. The display shows 
the first advanced fax feature “BROADCASTING” on the 
bottom line.

5 Press the Scroll buttons (  or ) until you see “ADD 
SCHEDULE” on the bottom line then press Enter. 

The display shows the information of the last job reserved in 
the memory.

6 Press the Scroll buttons (  or ) repeatedly until you find 
the operation to which you want to add documents, then 
press Enter.

The product automatically stores the documents in the 
memory in the black and white mode, and the display shows 
the memory capacity and the number of pages.
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If you the document is fed from the document glass, the 
display shows “NEXT GO ON?” on the top line after the 
document is scanned into the memory. If you have the next 
page, remove the scanned page and load the next page on the 
glass and press Enter. Repeat as necessary.

When all pages are scanned, press Cancel/Reset when the 
display shows “NEXT GO ON?.”

7 After storing, the product displays the number of total pages, 
then returns to Standby mode.

Cancelling a Scheduled Operation

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) until you see 
“4.ADVANCED FAX” and then press Enter. The display shows 
the first advanced fax feature “BROADCASTING” on the 
bottom line.

3 Press the Scroll buttons (  or ) until you see “CANCEL 
SCHEDULE” on the bottom line and then press Enter. 

The display shows the information of the last job reserved in 
the memory.

4 Press the Scroll buttons (  or ) repeatedly until you find 
the operation you want to cancel and then press Enter. The 
selected job is cancelled.
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Additional Features

Printing Reports

Your product can print reports containing useful information – 
Schedule Job, System Data, etc. The following reports are 
available: 

Help List

This list shows the product’s basic functions and commands to use 
as a quick reference guide. 

Sent Journal

This report shows information concerning transmission activities 
recently made. 

Received Journal

This report shows information concerning reception activities 
recently made. 

Phonebook

This list shows all of the numbers currently stored in the product’s 
memory as one-touch dial numbers, Speed dial numbers and 
Group dial numbers. 

Sending Confirmation

This report shows the fax number, the number of pages, elapsed 
time of the operation, the communication mode, and the 
communication results.

You can set up your product to print the message confirmation 
report in one of the following ways: 

• Automatically after each transmission (ON)

• Automatically only if an error occurs during transmission (ERR)

• No report printed at all (OFF). You can print this report manually 
at any time you want.
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Schedule Information

This list shows the document currently stored for Delayed Sending, 
Priority Sending, Group Sending, and TX polling. The list shows the 
starting time, type of operation, etc. 

System Data

This list shows the status of System Setup, Fax Setup, and Copy 
Setup options. After you change any setting, print this list to 
confirm your changes. 

Self Test Page

This page shows the pattern indicating the status of the cartridge 
nozzle. You can check if the product is printing correctly using this 
page.

CID (Caller Identification) List

This list shows the 30 last numbers you received if you have the 
Caller Line Identification Service provided by the network. You can 
check the phone number of the caller and the date and time when 
the call was received.

Junk Fax List

This list shows the fax numbers defined as junk fax number by 
using the Junk Fax Setup menu (see page  5.46). When the Junk 
Fax Barrier feature is turned on, the incoming faxes from those 
numbers will be blocked.

Multi-Communication Report 

This report is printed automatically after sending documents to 
more than one location. 

Power Failure Report 

This report is printed out automatically when power is restored 
after a power failure if there occurs any data loss due to the power 
failure. 

NOTE: The list you have set to print out automatically will not print 
out when there is no paper loaded or a paper jam has occurred.
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Printing List

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) repeatedly until you see 
“5.REPORT/HELP” on the bottom line, and press Enter.

3 Press the Scroll buttons (  or ) repeatedly until you find 
the list you want to print. 

4 When the desired list displays, press Enter. The selected list 
will be printed.

Fax Setup Options

Your product has various user-selectable setup options for the fax 
system. These options are preset at the factory, but you may need 
to change them. To find out how the options are currently set, print 
the System Data list. For details on printing the list, see above.

Setting an Option

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) until you see “2.FAX 
SETUP” and then press Enter. The display shows the first 
option “SEND FROM MEMORY” on the bottom line.

3 Scroll through the options by pressing the Scroll buttons (  

or ) repeatedly.

4 When the option you want appears on the display, press 

Enter. The current setting is tagged with a  at the end of 
the display in bottom line.
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5 Choose the desired status by pressing the Scroll buttons (  

or ) repeatedly, and then press Enter to save the selection. 

6 Repeat to set other data options if necessary. 
You can exit from setup mode at any time by pressing 
Cancel/Reset.

Selectable Options

These instructions assume you’ve followed the steps under “Setting 
an Option” on page page 5.41 and the product is prompting you to 
change one of the options listed here.

• SEND FROM MEMORY : If you are annoyed that you have to wait 
until documents in the ADF are sent out when you try to send or 
reserve another fax, turn this feature on. This feature enables all 
transmission documents to be automatically scanned into 
memory before transmission.

Select ON to turn this feature on.

Select OFF to turn this feature off.

NOTE: If you set this option to ON color faxing will be disabled.

• SENDING CONFIRM : A message confirmation report shows 
whether the transmission was successful or not, how many pages 
were sent, etc.

Select ON to print a confirmation report automatically each time 
you send a fax.

Select OFF to turn this feature off.

Select ERROR to print only when an error occurs and the 
transmission was not successful.

• FAX PAPER SIZE : Select the paper size you will use for the 
recording paper. LETTER, A4, LEGAL sizes are available. 

NOTE: If you set the Auto Reduction menu option, or turned Paper 
Save mode on, your product will determine the reduction rate 
according to this setting.
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• AUTO REDUCTION : When receiving a document as long or 
longer than the paper loaded in your product, the product can 
reduce the received data to fit into your recording paper size.

Turn this feature on to reduce an incoming page that may need 
to be divided into two pages with only a few lines on the second 
page. If the product cannot reduce the data to fit onto one page 
with this feature enabled, the data will be divided and printed in 
actual size on two or more sheets if necessary.

Select ON to enable. Note that this feature does not apply to the 
copy mode.

Select OFF to turn this feature off. The overflow data will be 
printed out on a second page.

• SAVE TOLL TIME: You can set the toll save time for toll save 
transmission using the SAVE Toll button. For details on toll save 
transmission, see page 5.11.

Enter the desired time using the number keypad. If you have set 
the clock mode to 12 hour mode, you can toggle between AM and 
PM by pressing the Scroll buttons (  or ) repeatedly.

• RINGS TO ANSWER : You can select the number of times your 
product rings before answering an incoming call.

Enter a number using the number keypad.

• REDIAL INTERVAL : Your product can automatically redial a 
remote fax machine if it was busy or does not answer on the first 
call.

Enter the number of minutes using the number keypad.

• REDIAL COUNT : Enter the number of attempts to redial the 
number.

If you enter 0, the product will not redial.
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• STAMP RCV. NAME : Allows the product to automatically print 
the page number, and the date and time of the reception at the 
bottom of each page of a received document. 

Select ON to turn this feature on.

Select OFF to turn this feature off.

• RCV. START CODE : The remote receive code allows you to 
initiate fax reception from an extension phone plugged into the 
EXT jack. If you pick up the extension phone and hear fax tones, 
enter the remote receive code and the fax will start receiving. The 
password is preset to * 9 * at the factory.

Enter the desired code 0 to 9 on the number keypad.

• DRPD (Distinctive Ring Pattern Detection) MODE : 
‘Distinctive Ring’ is a telephone company service which enables a 
user to use a single telephone line to answer several different 
telephone numbers. The particular number someone uses to call 
you on is identified by different ringing patterns, which consist of 
various combinations of long and short ringing sounds. This 
feature is often used by answering services who answer 
telephones for many different clients and need to know which 
number someone is calling in on to properly answer the phone.

Using the Distinctive Ring Pattern Detection feature, your product 
can ‘learn’ the ring pattern you designate to be answered by the 
SCX-1150F product. Unless you change it, this ringing pattern will 
continue to be recognised and answered as a FAX call, and all 
other ringing patterns will be forwarded to the extension 
telephone or answering product plugged into the EXT jack. You 
can easily suspend or change Distinctive Ring Pattern Detection 
at any time.

Before using the Distinctive Ring Pattern Detection option, 
Distinctive Ring service must be installed on your telephone line 
by the telephone company. To setup Distinctive Ring Pattern 
Detection, you will need another telephone line at your location, 
or someone available to dial your fax number from outside.

Select ON to turn this mode on.
Select OFF to turn this mode off.
Select SET to setup the Distinctive Ring Pattern Detection. The 
LCD displays “WAITING RING.” Call your fax number from 
another telephone. It is not necessary to place the call from a 
product. When your product begins to ring, do not answer the 
call. The product requires several rings to learn the pattern.

When the product completes ‘learning’, the LCD displays “END 
DRPD SETUP.”
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With the DRPD feature active, “DRPD” appears in the display and 
the previously set reception mode is ignored. If you turn DRPD 
off, the product returns to any previously set reception mode.

NOTES:
• DRPD must be set up again if you re-assign your fax number, or 

connect the product to another telephone line.
• After DRPD has been set up, call your fax number again to verify 

that the product answers with a fax tone, then have a call placed to 
a different number assigned to that same line to be sure the call is 
forwarded to the extension telephone or answering product 
plugged into the EXT jack.

• ECM (Error Correction Mode) MODE : This mode compensates 
for poor line quality and ensures accurate, error-free 
transmission with any other ECM-equipped facsimile machine. If 
the line quality is poor, transmission time may be increased when 
ECM is enabled.

Select ON to turn the Error Correction mode on.

Select OFF to turn this Error Correction mode off.

• AUTO JOURNAL : A journal shows specific information 
concerning transmission or reception activities, the time and 
dates of up to 40 most recent transmissions or receptions.

Select ON to print the journal automatically after every 40 
transmissions or receptions.

Select OFF to print the journal manually.

• CALLER ID : When you receive a call, you can see the number 
of the person calling you if you have Line Identification Service 
provided by the network. (This option may not work when 
connected to a PABX.)

Select ON to display the caller ID.

Select OFF not to display the caller ID.

NOTE: The Caller ID option may be unavailable depending on your 
area or country.
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•  JUNK FAX BARRIER : With this feature set to ON, the system 
will not accept a fax sent from the remote station of which the fax 
number is stored in memory as junk fax number via the Junk Fax 
Setup menu below.

Select ON to turn this feature on. You can not receive from the 
registered stations.
Select OFF to turn this feature off. Anybody can send you a fax.

• JUNK FAX SETUP : You can register up to 20 fax numbers from 
the CID (Caller Identification) list as junk fax numbers. When the 
Junk Fax Barrier feature is turned on, the incoming faxes from 
those numbers will be blocked.

Select REGISTER to register a junk fax number. Press the Scroll 
buttons (  or ) to scroll through the CID list, and press Enter 
when the desired number is displayed. 
Select DELETE to delete a registered junk fax number. Press the 
Scroll buttons (  or ) to scroll through the list and press 
Enter when the desired number is displayed.
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Using the Fax Settings Utility

When you install the MFP driver, the Fax Settings Utility is 
automatically installed. With this program, you can configure the 
various fax setup options and store speed dial numbers on your 
computer. You can download the information to your SCX-1150F.

To install the MFP driver, see “Installing Samsung Software” on 
page 1.20.

Accessing the Fax Settings Utility

1 Click Start > Programs> SAMSUNG SCX-1150 Series> Fax 
Settings Utility.

2 The Samsung SCX-1150F Fax Settings Utility dialogue box 
opens.

3 After using the Fax Settings Utility, click Exit to close the 
dialogue box.

You can get online help by clicking the Help button.

In the case of Windows 98
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Settings Tab

Using the Settings tab on the Fax Settings Utility dialogue box, 
you can set up the fax name and number, and configure the fax 
setup options. For details on each setup option, see “Fax Setup 
Options” on page 5.41.

When you complete configuration, click Send to download the 
information to SCX-1150F.

The Defaults button allows you to restore the default status of 
each item.
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Phonebook Tab

Using the Phonebook tab, you can store the speed dial numbers 
(for details on speed dialling, see page 5.22).

•Get Phonebook: gets the speed dial numbers stored in memory 
of your product. 

•Send Phonebook: sends the speed dial numbers to your 
product. After storing a speed dial number, you must click this 
button to use the numbers on the operational panel your product. 

•Edit: allows you to store or edit a speed dial number. After 
selecting the desired speed dial location from the list, click this 
button. Then, enter a name and number in the Edit - Speed dial 
#X dialogue box (where X designates the selected speed dial 
location), and click OK to save.

•Delete: deletes the selected speed dial number.

•Delete All: deletes all the speed dial numbers. 

About Tab

The About tab gives you the program version number. If you click 
on the globe image on the bottom of the window, you will be 
connected to the Samsung web site provided you are the internet 
user.
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NOTE
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6 MAINTENANCE

This chapter provides suggestions for high-quality and 
economical printing and information for maintaining the 
print cartridge and your product. 

This chapter includes:

•Maintaining Print Cartridges

•Viewing Ink Level

•Cleaning Print Cartridges

•Replacing Print Cartridges

•Aligning Print Cartridges

•Clearing Memory

•Remote Test

•Cleaning the Document Glass
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Maintaining Print Cartridges  

To get the maximum benefit from your print cartridges:

• Do not remove a print cartridge from its packaging until you are 
ready to install it.

• Do not refill the print cartridges. The warranty does not cover 
damage caused by using refilled cartridges.

• Store the print cartridges in the same environment as your 
product.

• Do not remove a print cartridge from the product except to 
replace, or clean. Immediately replace the print cartridge or store 
in the storage unit. The print cartridge will not print correctly if 
removed from the product and left exposed for an extended 
period of time.

• Do not swap the colour cartridge with the black cartridge. The 
colour cartridge should be installed in the left carrier and the 
black cartridge in the right carrier.

• If you have an opened ink cartridge you are not currently using 
and do not have an available print cartridge storage unit, store it 
in an airtight plastic bag. Do not leave it exposed to air for an 
extended period; this promotes drying out and clogging of the 
print nozzles.

NOTE: If any (or both) cartridge(s) is not installed in the product, the 
display alerts you with the message “CHECK xxxx CARTRIDGE” 
(where xxxx designates the empty cartridge). Install the cartridge(s) 
to print properly. 

However, if you force to print out, your product can function even 
when any (or both) cartridge runs out of ink or is not installed. For 
example, if a fax is received when any cartridge is not installed, the 
display alerts with the message  “CHECK xxxx CARTRIDGE” and 
toggles “TO FAX PRINT PRESS ENTER.” If you press Enter, the product 
prints out the received fax with one (or no) cartridge installed. The 
print quality cannot be normal and you may see a white paper.
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Viewing Ink Level

You can view the ink level on the LCD display using the operation 
panel buttons. Take the following steps:

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) until you see 
“8.MAINTENANCE” and then press Enter. 

3 Press the Scroll buttons (  or ) until you see “VIEW INK 
LEVEL” on the bottom line of the display and then press Enter. 

4 The display shows the amount of ink remaining for the black 
(or photo) and the colour print cartridges. 

Cleaning Print Cartridges

Cleaning your print cartridges can improve the quality of printing. 
If your printed page is missing lines or dots or contains ink streaks, 
clean the print cartridges as described below.

There are two methods to clean the print cartridges:

• Print a head cleaning page, which can be done from the operation 
panel of your product or from the Control Program on your 
computer screen.

• Clean the print cartridge nozzles.

NOTE: Do not clean the print cartridges unnecessarily, as this wastes 
ink and shortens the life of the print cartridge.

Remaining ink Full capacity
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Printing a Cleaning Page from the Product 

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) until you see 
“8.MAINTENANCE” and then press Enter. 

The first maintenance option “CLEAN CARTRIDGE” appears on 
the bottom line of the display.

3 Press Enter to start the cleaning process. Your product prints 
a cartridge clean page.

4 Examine the cleaning pattern. Compare the diagonal lines at 
the top and bottom of the test pattern.  

A broken line shows any clogged nozzles. If the bottom line 
shows improvement, rerun this cleaning process two more 
times.

 If this process does not improve the print quality, your print 
cartridges may be low in ink. Replace the print cartridge, if 
necessary.

5 If the line is still broken, clean the print nozzles. See “Cleaning 
Print Cartridge Nozzles” on page 6.6.

Before purge

Purge process

After purge
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Printing a Cleaning Page from Your Computer

1 Click Start  > Programs > Samsung SCX-1150 Series > 
Printer Control Program. 

2 The Samsung SCX-1150 Series window appears. Select the 
Cartridges tab.

3 Click Clean Print Nozzles.

4 The product feeds a sheet of paper and prints a cleaning 
pattern. Examine the cleaning pattern. Refer to step 4 under 
“Printing a Cleaning Page from the Product” on page 6.4.

NOTE: In Windows 2000/XP, the Printer Control Program is 
unavailable. But, you can access the Cartridge Maintenance features 
through the printer properties by taking the following steps: 
1. Click Start > Settings > Printers.
2. Right-click on Samsung SCX-1150 Series printer in the 
    Printers folder.
3. From the pop-up list, select Properties.
4. Click the Cartridge Maintenance tab.

In case of Windows 98
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Cleaning Print Cartridge Nozzles

If print quality does not improve after repeatedly printing the 
cleaning page, the problem may be caused by dried ink on the print 
cartridges.

1 Open the cartridge door by grabbing the door handle at the 
top edge.

2 Remove the print cartridges. For details, refer to step 3 under 
“Replacing Print Cartridges” on page 6.12.

NOTES:
• Keep new and used print cartridges out of the reach of children.
• Once you have removed the print cartridges, ensure that they  are 

not out of the printer longer than 30 minutes.
• Be careful not to touch the ink nozzles or the electrical contacts. 

Touching these parts of the print cartridge can result in clogs, ink 
failure, or a bad electrical connection.
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3 Use a clean cloth, dampened with water only, to gently clean 
the entire copper coloured area, including the nozzles and 
contacts.

To dissolve any dried ink, place the cartridge on a heavy 
damp cloth as shown below and push the cartridge with light 
pressure to let the nozzles come in contact with the cloth for 
about three seconds. Then gently blot and wipe dry.

If you are cleaning a colour print cartridge, be especially 
careful to wipe the nozzles in only one direction so the 
colours do not mix.

4 Allow the copper-coloured area to dry.

5 Reinstall the print cartridges and close the cartridge door. 
The display shows “CARTRIDGE CHANGED? NO.” Press 
Enter. The display returns to Standby mode.

6 Print a cleaning page and examine the cleaning pattern by 
following the instructions on page 6.3. If the line is still 
broken, clean the print cartridge holder contacts in your 
product.

NOTE: Once the cartridges are removed and installed, cartridge 
alignment may be required. After you clean the cartridge, if 
necessary, align the cartridges.

Nozzles

Contact area

Wipe in only one 
direction.
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Cleaning Cartridge Holder Contacts

1 Open the cartridge door by grabbing the door handle at the 
top edge.

2 After the print cartridges have moved to the centre of the 
printer, unplug the power cord to turn the power off with the 
cartridge holder in the centre.

3 Remove the print cartridges. For details, refer to step 3 under 
“Replacing Print Cartridges” on page 6.12.
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4 Use a CLEAN, DRY CLOTH to clean the print cartridge contacts 
inside the printer.

5 Reinstall the print cartridges, then close the cartridge door. 

6 Plug the power cord back to the AC power outlet.

Replacing Print Cartridges

Your product is a dual cartridge inkjet printer. You must use a 
colour and a black (or photo) ink cartridge. 

An optional photo cartridge gives excellent, near photo quality 
printing. When you wish to use a photo cartridge, replace the black 
cartridge with the photo cartridge. When you finish using the photo 
cartridge, immediately swap it with the black cartridge because:

• Normal incoming faxes can not be printed when the photo 
cartridge is installed. They will be saved to memory so you may 
print them later.

• Photo cartridge should  be used for printing pictures. 

• Printing black with the photo cartridge installed will be much 
slower than using the black cartridge.

Cartridge contact
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There are two types of black and colour cartridge: Standard and 
High yield. Before proceeding to install, you need to check which 
cartridge type you have. When you install the cartridges, you will 
be asked if it is Standard or High Yield. To find out the type, refer 
to the table below.

When you notice the print becomes light or “CHANGE xxxx INK” 
(where xxxx designates the empty cartridge) appears in the 
display, replace the appropriate cartridge(s).

The print cartridge includes the ink supply and the print head. Each 
time you replace the ink cartridge you are replacing the print head 
as well.

Replacement of the print cartridges can be done from the operation 
panel of your product or from the computer using the Samsung 
SCX-1150 Series Control Program.

Cartridge type Part number

Black cartridge
High yield Lexmark 12A1975

Standard Samsung INK-M50 
Lexmark 12A1970

Colour cartridge

High yield Lexmark 15M0125

Standard Samsung INK-C60 
Lexmark 15M0120

Photo cartridge Lexmark 12A1990
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Replacing Print Cartridges from the Product

1 Carefully unwrap the new ink cartridge(s) and remove the 
sealing tape. Slowly pull straight out.

NOTE: Avoid touching the electrical contacts on the cartridge. 
Ensure that there are no pieces of tape remaining on the cartridge.

2 Open the cartridge door by grabbing the door handle on the 
top edge. The print cartridge carrier moves to the centre 
position of the product.
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3 Locate the print cartridge holder inside the product. The black 
(or photo) ink cartridge holder is located on the right side of 
the cartridge holder and the colour ink cartridge is located on 
the left side.

4 Pull the old cartridge(s) toward you until you hear a click and 
then remove the cartridge(s) from the holder.

5 Place the new print cartridge(s) into the holder and push it 
until it clicks into place.

6 Close the cartridge door. The display prompts you to confirm 
the changed cartridge(s). 

You can choose from NO, LEFT, RIGHT, and BOTH by using the 
Scroll buttons (  or ). Press Enter when your choice 
appears in the display. 

NOTE: If the display shows “REMOVE PAPER JAM AND PRESS 
CANCEL” when you have closed the cartridge door, re-install the 
cartridge(s). With the print cartridge(s) installed improperly, the 
product might not print.

Colour ink cartridge

Black (or photo)
ink cartridge
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7 The display prompts you to confirm a new or an old cartridge. 

Press the Scroll buttons (  or ) to scroll through the 
options and press Enter when your choice appears in the 
display.

The available options for the right cartridge are: NEW BLACK, 
OLD BLACK, NEW PHOTO, and OLD PHOTO. If you installed a 
photo cartridge instead of a black cartridge, select “NEW 
PHOTO” or “OLD PHOTO”.

8 The display prompts you to confirm the cartridge capacity: 

Standard or High Yield. Use the Scroll buttons (  or ) to 
scroll through the options and press Enter when your choice 
appears in the display.

If you installed a photo cartridge, you don’t have to select the 
capacity of the photo cartridge because your product supports 
only a standard photo cartridge. 

9 When you finish setting the cartridge(s) and if any new 
cartridge is installed, the cartridge alignment procedure 
begins automatically by printing the Cartridge Alignment 
form.

Refer to step 5 under “Aligning Print Cartridges” on page 6.16.

If you installed an old cartridge(s), the product returns to 
Standby mode without printing the Cartridge Alignment form.

 NOTE: If you reinstall the printer driver, the ink level on the Printer 
Control Program may be incorrect even when you do not change the 
cartridges.

Replacing Print Cartridges from the Computer

1 Click Start > Programs > Samsung SCX-1150 Series > 
Printer Control Program. You have accessed the Samsung 
SCX-1150 Series Control Program.

2 Select the Cartridges tab. Click Install/Change Cartridge. 

3 Open the cartridge door and replace the old cartridge(s) by 
following the instructions on page 6.11.
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4 When you finish installing cartridge(s), click the appropriate 
buttons in the Samsung SCX-1150 Series dialogue box to 
confirm the type of the cartridges you have installed.

5 When you finish, click OK. If you have installed one or both 
cartridges as new, the message dialogue box appears to 
prompt you to align the cartridge. Click Align.

6 Your product prints the Cartridge Alignment form. Complete 
the alignment procedure by following the instructions on the 
page 6.17.

If you installed an old cartridge(s), the product returns to 
Standby mode without printing the Cartridge Alignment form.

 NOTE: In Windows 2000/XP, the Printer Control Program is 
unavailable. But, you can access the Cartridge Maintenance features 
through the printer properties by taking the following steps: 
1. Click Start > Settings > Printers.
2. Right-click on Samsung SCX-1150 Series printer in the Printers 
    folder.
3. From the pop-up list, select Properties.
4. Click the Cartridge Maintenance tab.

In the case of Windows 98
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Aligning Print Cartridges 

You must align the black and colour print cartridges after installing 
a new print cartridge or if the black portions of graphics do not align 
with the colour portions.

Cartridge alignment can be done from the computer using the 
Samsung SCX-1150 Series Control Program or from the operation 
panel of your product.

Aligning Print Cartridges from the Product

1 Press the Setup. The display shows “1.SYSTEM SETUP” on 
the bottom line.

2 Press the Scroll buttons (  or ) until you see 
“8.MAINTENANCE” and then press Enter. 

3 Press the Scroll buttons (  or ) until you see “ALIGN 
CARTRIDGE” on the bottom line of the display and then press 
Enter. 

4 The product feeds a sheet of paper and prints the Cartridge 
Alignment form. 
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5 From each group on the form, locate the number under the 
alignment pattern that comes closest to forming a perfectly 
straight line. 

6 The alignment entry menu appears on the display. The letter 
on the right end of the display corresponds to the alignment 
pattern. The range of numbers in the centre of the display 
indicates the range of valid selection choices. The flashing 
number on the left side of the display indicates the line from 
the form that is currently selected as optimal.

7 Using the number keypad enter the number of the line which 
appears the straightest from pattern A (example - for the 
second line, enter 02). 

Press Enter to confirm your selection. The alignment entry 
menu for the Alignment B pattern is displayed.

8 Repeat step 7 for Alignment patterns B through F (or D for 
colour and photo cartridges).

9 After you enter the number for the last group, Alignment F (or 
D for colour and photo cartridges), the display automatically 
returns to the Standby mode.

Aligning Print Cartridges from the Computer

1 Click Start > Programs > Samsung SCX-1150 Series > 
Printer Control Program. You have accessed the Samsung 
SCX-1150 Series Control program.

2 Select the Cartridges tab.

3 Click Align Cartridges.

Last alignment
entry

Number range Alignments 
(A, B, C, D, E, F)
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4 The product feeds a sheet of paper and prints the Alignment 
Cartridge form. The Align Cartridges dialogue box appears.

5 Locate the number under each alignment group in the pattern 
that comes closest to forming a perfect straight line. Then 
enter the number of the line or click repeatedly the  or  
key to select the number.

6 When the procedure is finished, click OK.

 NOTE: In Windows 2000/XP, the Printer Control Program is 
unavailable. But, you can access the Cartridge Maintenance features 
through the printer properties by taking the following steps: 
1. Click Start > Settings > Printers.
2. Right-click on Samsung SCX-1150 Series printer in the Printers 
    folder.
3. From the pop-up list, select Properties.
4. Click the Cartridge Maintenance tab.
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Clearing Memory

You can selectively clear information stored in your product’s 
memory.

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) until you see “7.MEMORY 
CLEAR” and then press Enter. 

3 Press the Scroll buttons (  or ) until you find the item you 
want to clear. The following options are available:

• FAX NUMBER/NAME: Your fax number and name are 
cleared from memory.

• DIAL/SCHEDULE: clears the phonebook numbers, 
one-touch, speed dial, or group dial numbers stored in the 
memory. Also, all Schedule Job operations reserved are 
canceled.

• JOURNAL: clears all records of transmissions & receptions.

• DEFAULT SETUP: restores all settings to factory default.

4 Press Enter when your choice appears in the bottom line of 
the display. The selected item is cleared and then the display 
returns to Standby mode.
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Remote Test

The Remote Test feature allows your product to be checked out by 
a service company at a remote place by phone.

1 Press Setup. The display shows “1.SYSTEM SETUP” on the 
bottom line.

2 Press the Scroll buttons (  or ) until you see 
“8.MAINTENANCE” and then press Enter. 

3 Press the Scroll buttons (  or ) until you see “REMOTE 
TEST” on the bottom line of the display and then press Enter. 
The current setting displays.

4 Press the Scroll buttons (  or ) to select “ON” to turn the 
feature on. If you want to protect your product from being 
accessed by unauthorized person, select “OFF”.

5 Press Enter to save the selection.
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Cleaning the Document Glass  

To keep your product working properly, occasionally clean the 
document glass.

Clean the document glass with a soft cloth. Do not spray the 
cleaner directly onto the document glass. Always spray the cleaner 
onto the cloth.

Document Glass
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7 TROUBLESHOOTING

This chapter gives helpful information for what to do if you 
encounter an error. 

This chapter includes:

•Clearing Document Jams

•Clearing Paper Jams

•LCD Error Messages

•Fixing Problems
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Clearing Document Jams

If a document jams while it is feeding through the ADF, 
“DOCUMENT JAM” appears in the display.

Details for clearing the three types of document misfeeds are given 
below.

Input Misfeed

1 Open the ADF top cover.

2 Carefully pull the jammed document out of the ADF 
mechanism, taking care not to tear the paper.

3 Close the ADF top cover.

4 Feed the documents back into the ADF.
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Exit Misfeed

1 Open the document cover and turn the roller knob to remove 
the misfeed documents from the exit area.

If the jammed document cannot be easily removed, skip to 
the Roller Misfeed section.

2 Close the document cover.

3 Feed the documents back into the ADF.

Roller Misfeed

1 Open the document cover and turn the roller knob to remove 
the misfeed document from the ADF or the exit area. If the 
document is difficult to remove, gently remove it from under 
the feeding roller.

2 Close the document cover.

3 Feed the documents back into the ADF.
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Clearing Paper Jams

If paper jams occur, “REMOVE PAPER JAM AND PRESS CANCEL” 
appears in the display. Follow the steps below to clear the jam. To 
avoid tearing paper, pull the jammed paper out gently and slowly.

If jammed in the paper feed area at the rear of the product:

1 Remove the stack of paper (if necessary).

2 Remove the jammed paper by gently pulling it straight up.

3 After you remove the jammed paper, reload the stack of paper 
back into the paper bin with the print side facing you. Before 
loading, ensure the edges of the stack of paper are even and 
straight.

4 Adjust the paper guide to match the width of the paper.
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5 If the paper jams as it exits to the paper output tray, remove 
the jammed paper by pulling gently on the paper.

6 Press Cancel/Reset to clear the error message on the 
display.

NOTE: If there is any resistance, and the paper does not move 
immediately when you pull, open the cartridge door and gently pull 
the jammed paper out of the printer.
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Tips for Avoiding Paper Jams

By carefully selecting print materials and loading them properly, 
you should be able to avoid most paper jams. If jams do occur, 
follow the steps outlined in “Clearing Paper Jams” starting on page 
7.4. If jams occur frequently, make sure that you are following 
these preventative tips:

• Follow the procedures in “Loading Paper” on page 1.11 to load 
paper properly. Make sure that the adjustable guides are 
positioned correctly.

• Do not overload the paper. Up to 100 sheets can be loaded in the 
paper bin at a time.

• Envelopes with self-stick adhesives may cause wrinkling, 
creasing, or even jams and may even damage your product.

• Fan stacks of labels or transparencies before loading them into 
the paper input bin. If jams occur, try feeding one sheet at a time.

• Do not load wrinkled, creased, damp, or highly curled paper.

• Do not mix paper sizes in the paper input bin.

• Use only recommended print media. 

• Make sure that the recommended print side is facing up when 
loading it in the paper input bin.

• Keep print media stored in a suitable environment.
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LCD Error Messages

LCD Display Meaning Solution

CHECK CARTRIDGES 
CHECK LEFT 
CARTRIDGE
CHECK RIGHT 
CARTRIDGE

The indicated ink cartridge 
is not installed or installed 
improperly. Or there is a 
problem on the indicated 
cartridge. 

Following the procedure in 
“Replacing Print Cartridges” 
on page 6.9, remove and re-
install the print cartridge.

CHANGE COLOR INK 
CHANGE BLACK INK 
CHANGE PHOTO INK 

The indicated ink cartridge 
is low or out of ink.

Install a new ink cartridge.

COVER OPEN The cartridge door is not 
securely latched.

Press down on the cartridge 
door until it clicks in place.

REMOVE PAPER JAM 
AND PRESS CANCEL

Paper jammed while 
printing.

Clear the jam. Refer to 
“Clearing Paper Jams” on 
page 7.4.

SYSTEM ERROR Internal system errors 
detected.

Look for obvious error 
conditions. If the problem 
persists, power the product 
off and on. Contact the 
nearest dealer.

ADD PAPER 
THEN PRESS ENTER

The paper bin is empty. If the product runs out of 
paper while printing, it will 
restart printing when more 
paper is loaded. Press Enter 
after loading paper.

PRINTER ERROR An unknown printer error 
has occurred.

Turn off your product then on. 
If you still have the problem, 
please contact your dealer.

SYSTEM BUSY You have tried to use the 
system when it is currently 
in use.

Wait for the current job to 
complete, then try again.

DOCUMENT JAM The loaded document has 
jammed in the ADF.

Clear the document jam. See 
page 7.2.

LOAD BLACK INK The photo cartridge is 
installed when:
- receiving a fax
- copying in Draft quality

Replace the photo cartridge 
with black one.
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CID NUM. EMPTY You have attempted to 
register a junk fax number 
when the CID list is empty.

The CID list is created when 
Caller Line Identification 
service is available. Make sure 
that you have  subscribed to 
the service and there is a 
number in the CID list.

LINE ERROR Your unit cannot connect 
with the remote machine, 
or has lost contact because 
of a problem on the phone 
line.

Try again. If failure persists, 
wait an hour or so for the line 
to clear, and try again. 
Or, turn the ECM mode on. 
See “Fax Setup Options” on 
page 5.41.

LOAD DOCUMENT You have attempted to set 
up a sending operation 
with no document loaded.

Load a document and try 
again.

MEMORY FULL The memory is full. Either delete unnecessary 
documents, or retransmit 
after more memory becomes 
available, or split the 
transmission into more than 
one operation.

MEMORY JOB 
NOT ASSIGNED

You attempted to add 
documents when there is 
no scheduled job.

Check the display if there is 
any scheduled job. The 
display should indicate the job 
in Standby mode (for 
example, DELAY TX or SAVE 
TOLL).

NO ANSWER The remote machine has 
not answered after all the 
redial attempts.

Try again. Make sure the 
remote machine is 
operational.

NO. NOT ASSIGNED The one-touch or speed 
dial location you tried to 
use has no number 
assigned to it.

Dial the number manually 
with the keypad, or assign a 
number.

PC NOT AVAILABLE Your product is not 
properly connected to your 
PC.

Check the cable connection 
between the product and the 
PC. Connect properly using a 
parallel or USB cable. See 1.7.

LCD Display Meaning Solution
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POLLING ERROR The remote fax machine 
you want to poll is not 
ready to respond to your 
poll.

Or

When setting up to poll 
another fax machine, you 
have used an incorrect poll 
code.

The remote operator should 
know in advance that you are 
polling and have their fax unit 
loaded with the original 
document.

Or

Enter the correct poll code.

RECEIVE ERROR A fax has not been 
received 
successfully.

A problem with the facsimile 
communications has 
occurred. Ask the sender to 
try again.

REMOVE PAPER JAM 
AND PRESS CANCEL

Recording paper has 
jammed.

Clear the jam and press 
Cancel/Reset.

RETRY REDIAL? The product is waiting for a 
specified time interval to 
redial a station which was 
busy or did not answer 
previously.

You can press Enter to 
immediately redial, or 
Cancel/Reset to cancel the 
redial operation.

SEND ERROR Your fax has not gone 
through successfully.

A problem with the facsimile 
communications has 
occurred. Try again.

TX NOT AVAILABLE You have attempted to 
send a document while the 
product is printing received 
data.

Send the document after the 
current job is completed.

WRONG PIN CODE You have entered the 
wrong PIN Code.

Re-enter the correct four 
digits of the PIN code.

SEND ERROR Your fax has not gone 
through successfully.

A problem with the facsimile 
communications has 
occurred. Try again.

LCD Display Meaning Solution
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Fixing Problems

Fax Problems

Symptom Cause and Solution

The product is not 
working, there is no 
display and the 
buttons are not 
working.

• Unplug the power cord and plug it in again.

• Check that your socket is active.

No dial tone.
• Check that the phone line is connected properly.

• Check that the phone socket in the wall by plugging in 
another phone. 

The numbers stored in 
the memory do not 
dial correctly.

• Make sure that the numbers are stored in the memory 
correctly.

• Print a Phonebook list. See page 5.39.

The document does 
not feed into the 
product.

• Make sure that the document is not wrinkled and you are 
putting it in correctly. Check the document is the right 
size, not too thick or thin. 

• Make sure that the cover is firmly closed.

You cannot receive 
faxes automatically.

• The FAX  mode should be selected. 

• Is there paper in the product?

• Check if the display shows ‘MEMORY FULL.’

Your product cannot 
receive faxes 
manually.

Did you hang up the handset of the external telephone 
before you pressed any of the Start FAX buttons?

Your product will not 
send anything.

• Make sure that the document is loaded face up in the ADF 
and face down in the document glass. 

• “TX” should show up on the display. 

• Check the other fax machine you are sending to, to see if 
it can receive your fax.

You cannot poll 
another machine.

The fax machine you are polling may be using a poll code.
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The incoming fax has 
blank spaces or you 
received a poor-
quality copy.

• The fax machine sending you the fax may be faulty. 

• The fax machine sending you a fax may have a dirty scan 
glass.

• A noisy phone line can cause line errors. 

• Check your product by making a copy. 

• The print cartridge may be empty.

• Haven’t you force the product to print out with any (or 
both) cartridge not installed? Your product can function 
with only one or no cartridge installed, but the quality 
cannot be normal.

Are some of the words 
on the incoming fax 
stretched?

The fax machine sending you the fax had a temporary 
document jam. 

There are lines on the 
copies or documents 
you send.

Check your scan glass for marks, and clean it. See page 
6.20.

The product dials a 
number, but fails to 
make a connection 
with another fax 
machine.

The other fax machine may be turned off, out of paper, or 
cannot answer incoming calls. Speak with the other 
machine operator and ask them to sort out the problem.

You cannot store a 
document in the 
memory.

There may not be enough memory to store the document. If 
the display shows “MEMORY FULL”, delete any documents 
you no longer need from the memory, then restore the 
document.

Blank areas appear at 
the bottom of each 
page or on other 
pages, with only a 
small strip of text 
printed at the top.

You may have chosen the wrong paper settings in the user 
option setting. See page 5.42 to choose a proper paper 
size.

Symptom Cause and Solution
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Paper Feeding Problems

Symptom Cause and Solution

Paper is jammed 
during printing.

Clear the paper jam. See page 7.4.

Paper sticks together. • Ensure there is not too much paper in the paper bin. 
Depending on the thickness of your paper, the paper bin 
can hold up to 100 sheets of paper.

• Make sure you are using the correct type of paper. See 
“Paper Selection” on page 2.2.

• Remove paper from the paper bin and flex or fan the 
paper.

• Humid conditions may cause some paper to stick together.

Paper fails to feed. • Remove any obstructions inside the product.

Multiple sheets of 
paper do not feed.

• Different types of paper may be stacked in the paper bin. 
Load the paper of only one type, size, and weight.

• When loading paper, do not force the paper down into the 
printer.

• If multiple sheets have caused a paper jam, clear the 
paper jam. See page 7.4.

Paper skews or 
buckles.

• Ensure there is not too much paper in the paper bin. 
Depending on the thickness of your paper, the paper bin 
can hold up to 100 sheets of paper.

• Make sure the paper guide does not cause the paper to 
bow in the paper bin.

• Make sure you are using the correct type of paper. See 
“Paper Selection” on page 2.2.

• When loading paper, do not force the paper down into the 
product.

• Make sure the right side of the paper is aligned with the 
right edge of the paper bin, and the left paper guide is set 
against the left side of the paper.

Transparencies stick 
together in the paper 
exit.

Use only the transparencies specially designed for an ink jet 
printer. Remove each transparency as it exits from the 
printer.

Envelopes skew or fail 
to feed correctly.

Ensure that the paper guide is against the left side of the 
envelopes.
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General Printing Problems

Symptom Cause and Solution

Your product does not 
print.

• The printer cable is not connected properly. Check the 
printer cable connection.

• The printer cable is defective. Swap the cable with one 
known to work. 

• The port setting is incorrect. Check the Windows printer 
settings to make sure that the print job is being sent to 
the correct port (for example, LPT1).

• The print cartridge is not installed properly. Remove and 
reinsert the print cartridge.

• The printer properties may be configured incorrectly. 
Check the application to make sure that all print settings 
are correct.

• The printer driver may be incorrectly installed. Uninstall 
the MFP driver and reinstall the MFP driver. Then try 
printing a test page. Refer to “Uninstalling Samsung 
Software” on page 1.28.

• A paper jam has occurred. Remove the jammed paper. 
See page 7.4.

• For Windows 2000/XP, if you remove the product from 
the PC and then connect back to the PC, the printer 
might be set to Off line status. Open the Windows 
Printer folder and check if the product is off line. If so, 
right-click on Samsung SCX-1150 Series printer and 
deselect Use Printer Offline.

A file sent from 
Acrobat Reader 4.0 
does not print or print 
improperly.

• From the Acrobat Reader File menu, select Print and 
check the Print as image box. If it does not solve the 
problem, upgrade Acrobat Reader to 5.0 or higher.

The paper is not fed 
into the product.

• Paper has not been inserted correctly. Remove and 
reinsert the paper correctly (refer to “Loading Paper” on 
page 1.11).

• There is too much paper in the paper bin. Remove some 
of the paper from the paper bin.

The paper keeps 
jamming.

• There is too much paper in the paper bin. Remove some 
of the paper from the paper bin. (If printing onto 
transparencies, or labels, insert them one at a time.)

• The paper setting method may be incorrect. If printing 
onto envelopes, insert the envelopes so that there is a 
gap of approximately 1 mm (1/32”) between the left and 
right edge of the envelopes at the paper guide.
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Part of the printed 
page is blank.

• The page layout is too complex. Simplify the page layout 
and remove any unnecessary graphics from the 
document if possible.

• The page orientation setting may be incorrect. Change 
the page orientation in the Printer Properties dialogue 
box.

• The paper size and the software paper size settings do 
not match. Insert the correct paper into the product or 
change the software paper size settings.

• Scaling may be set to less than 100%. Change the 
Scaling setting in the Printer Properties dialogue box.

• If using a parallel cable, ensure that it is compliant with 
an IEEE-1284 rated cable.

Your product prints 
the wrong data, or it 
prints incorrect 
characters.

• The printer cable might not be connected properly. Check 
the printer cable connection.

• There may be a problem with the printer driver software. 
Exit Windows and reboot the computer. Turn the printer 
off and then back on again.

• If using a parallel cable, ensure that it is compliant with 
an IEEE-1284 rated cable.

Printing is too slow. • You may be using High and Maximum print quality. 
See page 2.10.

• If you are using Windows NT, the Scheduling setting may 
be set incorrectly. From the Start menu, select Settings 
and Printers. Click your printer icon with the right 
mouse button, select Properties, click the Scheduling 
tab. Then, select the desired scheduling setting from the 
available choices.

When printing using 
the USB connection, 
an error occurs 
repeatedly.

When the USB mode is set to “FAST”, the communication 
between the product and the computer may be poor. 
Change the USB mode to “SLOW”. To do so, take the 
following steps:
1. Press Setup on the operation panel. You can see

“1.SYSTEM SETUP” on the bottom line of the display.
2. Press Enter.
3. Press the Scroll buttons (  or ) until you see 

“USB MODE” and then press Enter.
4. Press the Scroll buttons (  or ) to select “SLOW”

and then press Enter to save the selection.

Symptom Cause and Solution
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Colour Printing Problems

Symptom Cause and Solution

Your product prints 
only in black.

• The Samsung SCX-1150 Series printer driver may not be 
selected. Verify that you selected the Samsung SCX-1150 
Series printer driver.

• The colour print cartridge may not be working properly. 
Print a test page to make sure the ink cartridges are 
working correctly.

• The print nozzles of the colour print cartridge may need to 
be cleaned. Clean the print cartridges. See page 6.3.

• You may be using Black Only in your printer driver.

Colour prints 
incorrectly.

• The Samsung SCX-1150 Series printer driver may not be 
selected. Verify that you selected the Samsung SCX-1150 
Series printer driver.

• Print cartridges may be installed in the incorrect holders. 
Remove each print cartridge that is in  an incorrect holder. 
Check that the ink have not mixed in the cartridges. If this 
is the case, replace the cartridge with a new one.

• Print a test page. If the problem persists, replace the 
cartridge with new one.

• Print nozzles on the colour print head may be clogged. 
Print a test page to check the status of the nozzles and 
clean the print cartridge (see page 6.3).

Colours are missing. • The colour print cartridge may be not working properly. 
Print a test page to make sure the ink cartridge is working 
correctly.

• The print head may need to be cleaned. Clean the print 
cartridges (see page 6.3).

Colours in a line are 
uneven, or different 
from the previous 
lines.

• You may have turned the product off(paused) and then 
on(resumed) during print job. Do not turn the product off 
and back on during a print job.

• Set the print quality to High or Maximum in the printer 
driver.

• Align the print cartridges. See page 6.15.

Hue changes. • Print nozzles on the print head may be clogged. Print a 
test page to check the status of the nozzles and clean the 
print cartridge (page 6.3).

• The colour print cartridge may be empty. Replace the 
cartridge with a new one.
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Print Quality Problems

Symptom Cause and Solution

Light print or fade • The print cartridge may be running out of ink. Install a 
new ink cartridge.

• The paper may not meet paper specifications (for 
example, the paper is too moist or too rough). See “Paper 
Selection” on page 2.2.

• If the whole page is light, the print resolution setting is 
too low. Adjust the print resolution within the printer 
properties. See page 2.10.

• A combination of faded and smeared defects may indicate 
that the print cartridges need to be cleaned. See 
“Cleaning Print Cartridges” on page 6.3.

Splashed dots • The paper may not meet paper specifications (for 
example, the paper is too moist or too rough). “Paper 
Selection” on page 2.2.

• The print nozzles may be clogged with ink. See “Cleaning 
Print Cartridges” on page 6.3.

White streaks or 
missing dots

• The moisture content of the paper is uneven or the paper 
has moist spots on its surface. Try a different kind or 
brand of paper.

• Print cartridges may be installed incorrectly. Make sure 
the print cartridges are installed correctly.

• A print cartridge may be empty. Check the contacts of the 
print cartridge. If there is not any ink in the cartridge, 
replace it with a new one.

• The print media being used may not be acceptable. Use 
only print media specified in “Paper Selection” on page 
2.2.

• The print head may be aligned incorrectly. Print the 
alignment pattern to align the print cartridge. See page 
6.15.

Blurred or smudged 
ink

• You may printing on the wrong side of the paper. Turn the 
paper over and print on the other side.

• The paper may not meet paper specifications (for 
example, too moist or too rough). See “Paper Selection” 
on page 2.2.

• Let the ink dry before handling the paper.
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Characters with white 
lines

• The print cartridge may be almost empty. Check the 
contacts of the print cartridge and replace, if necessary.

• The print cartridges may need to be cleaned. See page 
6.3.

Characters are 
improperly formed or 
not aligned correctly

• The print media is loaded incorrectly or is an unsupported 
size or type. Use the print media specified in “Paper 
Selection” on page 2.2.

• If characters are improperly formed, producing a wavy 
effect, the scanner unit may need servicing. 

• The print cartridges may need to be cleaned. See page 
6.3.

• The print cartridges may need to be aligned. See page 
6.15.

Vertical lines in tables, 
borders and graphics 
not smooth

• The print cartridge may need to be cleaned. See page 6.3.

• The print cartridge may need to be aligned. See page 
6.15.

Solid black areas 
contain white streaks

• Change the fill pattern in the application software.

Printing appears 
jagged

• The print resolution selected in the printer driver may be 
low. Check the printer driver for the correct resolution. 
Printing in low resolution will give the printout a jagged 
look. Change the Print Quality to a higher resolution.

Symptom Cause and Solution
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Scanning Problems

Symptom Cause and Solution

The scanner does not 
scan.

• Make sure you place the document to be scanned face 
down on the document glass.

• There may not be enough available memory to hold the 
document you want to scan. Try the Pre-Scan function to 
see if that works. Try lowering the scan resolution rate.

• The USB or parallel cable is not connected properly.

• The USB or parallel cable is defective. Swap the cable with 
a known good cable. If necessary, replace the cable.

• If using a parallel cable, ensure that it is compliant with 
the IEEE 1284 standard.

• The scanner is configured incorrectly. Check scan setting 
in the SmarThru Configuration or the application you want 
to use to make certain that the scanner job is being sent 
to the correct port (for example, LPT1).

The unit scans very 
slowly.

• Graphics are scanned more slowly than text.

• Communication speed becomes slow in scan mode 
because of the large amount of memory required to 
analyse and reproduce the scanned image. Set your 
computer to ECP printer mode through BIOS setting. It 
will help to increase the speed. For details on how to set 
BIOS, refer to your PC documentation.

The following message 
appears on the 
computer screen: 
Scanner is busy 
receiving or printing 
data. When the 
current job is 
completed, try again.

There may be a copying or printing job in progress. When 
the current job is completed, try  the job again.
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8 APPENDIX

This chapter includes:

•Printer Specification

•Scanner and Copier Specification

•Fax Specification

•General Specification

•Paper Specification

•Replacing the Fitted Plug (UK)

•Notes For Use of This Device (New Zealand)

•Declaration of Conformity (European Countries)

•Fax Branding (US)

•Telephone Company Information (US)
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8.2 Appendix

Printer Specification

Scanner and Copier Specification

Item Description

Emulation HBP(GDI)

Resolution True 600 x 1200 dpi, 2400(H) x 1200(V) dpi

Printing speed (Draft Mode) 14 ppm (Mono)
7 ppm (Colour)

Effective printing width 203 + 1 mm

Item Description

Scanning method CCD, Flat-bed

Scan resolution 600 x 600 dpi, 1200 dpi class

Scan mode True colour, 256 grey, Black and white

Copy mode Colour, Black and white

Effective scanning width 210 mm

Maximum document width 216 mm

Multi copy range 1 ~ 99

Reduction & Enlargement 25% ~ 400% in 1% increment (Flatbed)
25% ~ 100% in 1% increment (ADF)

Maximum print edge margin Top: MAX 4mm
Bottom: MAX 5mm
Side: Letter — 6.5 ± 2 mm
         A4 — 3.5 ± 2 mm
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Fax Specification

Item Description

Applicable line G3 PSTN (Public Switched Telephone Network)

Compatibility ITU Group 3

Resolution Standard: 203 x 98 dpi

Fine: 203 x 196 dpi

Super Fine: 300 x 300 dpi

Data coding MH/MR/MMR/JPEG

Maximum modem speed 33.6 kbps

Transmission speed 3 sec. (Standard resolution, MMR, 33.6 kbps)

Memory 4 Mbytes

Effective scanning width 210 mm

Effective printing width 203 mm

Document width and 
weight

ADF: 176 ~ 216 mm, 16 lb ~ 24 lb

Document glass: Maximum 8.5 x 14 inches

Document capacity ADF: up to 30 pages (20 lb)

Document glass: 1 page
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General Specification

Item Description

Input paper tray capacity 100 sheets (Maximum)
Stacking Height : 9 mm

Output tray capacity Maximum 30 Sheets

Operating Environment Temperature: 5-40 degrees C (20 ~ 80% RH)

Paper size and weight A4, Letter, Legal

Original document width and 
weight

8.5 inch x 11.69 inch (A4/Letter Sized)

Power rating See Rating Label attached on the back of the 
machine.

Power consumption 10 W in Power save mode
15 W in Standby mode
30 W during copy

Weight 9.5 kg

Dimensions (WxDxH) 18.7 x 16.9 x 9.9 inch (476 x 429 x252 mm)

Ink Cartridge Life Black Cartridge   High yield: 1,100 sheets
                         Standard: 600 sheets
(based on ITU 5% chart* in PC Draft print 
mode) 

* See “A Sample of ITU 5% Chart (reduced to 60%)” on page 8.6.

Colour Cartridge    High yield: 625 sheets
                           Standard: 275 sheets
(based on ITU 15% chart  in PC Draft print 
mode)

Photo Cartridge: 450 sheets
(based on ITU 15% chart  in PC Draft print 
mode)
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Paper Specification

Item Description

Paper types 
available

Plain paper, OHP film, Label, Envelope, Card, Postcard

Paper sizes Paper Type W x L (mm) W x L (Inch)

Letter 215.9 x 279 8.5 x 11

Legal 215.9 x 355.6 8.5 X 14

JIS B5 182 x 257 7.17 x 10.12

A4 210x 297 8.27 x 11.69

Executive 184.2 x 266.7 7.25 x 10.5

A5 148.5 x 210 5.85 x 8.27

A6 card 105 x 148.5 4.13 x 5.85

Post Card 4x6 101.6 x 152.4 4 x 6

HagaKi 100 x 148 3.94 x 5.83

Envelope 7-3/4 98.4 x 190.5 3.88 x 7.5

Envelope COM-10 105 x 241 4.13 x 9.5

Envelope DL 110 x 220 4.33 x 8.66

Envelope C5 162 x 229 6.38 x 9.02

Custom 76 ~ 216 x 
127 ~ 432

2.99 ~ 8.5 x 
5 ~ 17
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A Sample of ITU 5% Chart   (reduced to 60%)
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Replacing the Fitted Plug (UK)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and 
has a 13 amp fuse. When you change or examine the fuse, you must re-fit the correct 
13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, 
do not use the plug until you have another fuse cover. 
Please contact the people from you purchased the machine.
The 13 amp plug is the most widely used type in the UK and should be suitable. 
However, some buildings (mainly old ones) do not have normal 13 amp plug sockets. 
You need to buy a suitable plug adaptor. Do not remove the moulded plug.

Important warning: You must earth this machine.

The wires in the mains lead have the following colour code:
• Green and Yellow:       Earth
• Blue:                         Neutral
• Brown:                      Live

If the wires in the mains lead do not match the colours marked in your plug, do the 
following:
You must connect the green and yellow wire to the pin marked by the letter ‘E’, or by 
the safety ‘Earth symbol’ or coloured green and yellow or green.
You must connect the blue wire to the pin which is marked with the letter ‘N’ or 
coloured black.
You must connect the brown wire to the pin which is marked with the letter ‘L’ or 
coloured red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

Warning

If you cut off the moulded plug, get rid of it straight away.
You cannot rewire the plug and you may receive an electric shock 

if you plug it into a socket.
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Notes For Use of This Device (New Zealand)

The grant of a Telepermit for any item of terminal equipment indicates only that 
Telecom has accepted that the item complies with minimum conditions for connection 
to its network. It indicates no endorsement of the product by Telecom, nor does it 
provide any sort of warranty. Above all, it provides no assurance that any item will 
work correctly in all respects with another item of Telepermitted equipment of a 
different make or model, nor does it imply that any product is compatible with all of 
Telecom’s network services.

This equipment shall not be set up to make automatic calls to the Telecom ‘111’ 
Emergency Service.

This equipment may not provide for the effective hand-over of a call to another device 
connected to the same line.

Important Notice

Under power failure conditions, this telephone may not operate. Please ensure that a 
separate telephone, not dependent on local power, is available for emergency use.
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Declaration of Conformity (European Countries)

Approvals and Certifications

The CE marking applied to this product symbolises Samsung Electronics Co., Ltd. 
Declaration of Conformity with the following applicable 93/68/EEC Directives of the 
European Union as of the dates indicated:

January 1, 1995: Council Directive 73/23/EEC Approximation of the laws of the 
member states related to low voltage equipment.

January 1, 1996: Council Directive 89/336/EEC (92/31/EEC), approximation of the 
laws of the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and 
telecommunications terminal equipment and the mutual recognition of their 
conformity.

A full declaration, defining the relevant Directives and referenced standards can be 
obtained from your Samsung Electronics Co., Ltd. representative.

EC Certification

Certification to 1999/5/EC Radio Equipment & Telecommunications 
Terminal Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European single 
terminal connection to the analogue public switched telephone network (PSTN) in 
accordance with Directive 1999/5/EC. The product has been designed to work with 
the national PSTNs and compatible PBXs of the European countries:

In the event of problems, you should contact the Euro QA Lab of Samsung Electronics 
Co., Ltd. in the first instance.

The product has been tested against TBR21 and/or TBR 38. To assist in the use and 
application of terminal equipment which complies with this standard, the European 
Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 
201 121) which contains notes and additional requirements to ensure network 
compatibility of TBR21 terminals. The product has been designed against, and is fully 
compliant with, all of the relevant advisory notes contained in this document. 
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Fax Branding (US)

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to 
use a computer or other electronic device to send any message via a telephone 
facsimile machine unless such message clearly contains in a margin at the top or 
bottom of each transmitted page or on the first page of the transmission the following 
information:

• the date and time of transmission

• identification of either business, business entity or individual sending the message; 
and

• telephone number of either the sending machine, business, business entity or 
individual.

See “Setting Fax Number and Name” on page 1.36 for instructions on how to enter 
this information into your Samsung FAX machine’s memory.

The Telephone Company may make changes in its communications facilities, 
equipment operations, or procedures where such action is reasonably required in the 
operation of its business and is not inconsistent with the rules and regulations in FCC 
Part 68. If such changes can be reasonably expected to render any customer terminal 
equipment incompatible with telephone company communications facilities, or 
require modification or alteration of such terminal equipment, or otherwise materially 
affect its use or performance, the customer shall be given adequate notice in writing, 
to allow the customer an opportunity to maintain uninterrupted service.

Telephone Company Information (US)

FCC IDENTIFICATION NUMBER

The Ringer Equivalence Number and FCC Registration Number for this equipment 
may be found on the label located on the bottom or rear of the machine. In some 
instances you may need to provide these numbers to the telephone company.

RINGER EQUIVALENCE NUMBER

The Ringer Equivalence Number (REN) is a measure of the electrical load placed on 
the telephone line, and is useful for determining whether you have “overloaded” the 
line. Installing several types of equipment on the same telephone line may result in 
problems making and receiving telephone calls, especially ringing when your line is 
called. The sum of all Ringer Equivalence Numbers of the equipment on your 
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telephone line should be less than five in order to assure proper service from the 
telephone company. In some cases, a sum of five may not be usable on your line. If 
any of your telephone equipment is not operating properly, you should immediately 
remove it from your telephone line, as it may cause harm to the telephone network.

WARNING:
FCC Regulations state that changes or modifications to this equipment not expressly 
approved by the manufacturer could void the user’s authority to operate this 
equipment.

In the event that terminal equipment causes harm to the telephone network, the 
telephone company should notify the customer that service may be stopped. 
However, where prior notice is impractical, the company may temporarily cease 
service, providing that they:
a) Promptly notify the customer.
b) Give the customer an opportunity to correct the equipment problem.
c) Inform the customer of the right to bring a complaint to the Federal 
    Communication Commission pursuant to procedures set out in FCC Rules and 
    Regulations Subpart E of Part 68.

You should also know that:
• Your Samsung FAX machine is not designed to be connected to a digital PBX 

system. 

• Special features, such as “Call Waiting”, may interrupt FAX service, and we suggest 
that these services not be installed on the FAX line.

• If you intend to use a computer modem or fax modem on the same phone line as 
your FAX machine, you may experience transmission and reception problems with 
all the equipment. It is recommended that no other equipment, except for a regular 
telephone, share the line with your FAX machine.

• If your area experiences a high incidence of lightning or power surges, we 
recommend that you install surge protectors for both the power and the telephone  
lines. Surge protectors can be purchased from your dealer or telephone and 
electronic specialty stores.

• When programming emergency numbers and/or making test calls to emergency 
numbers, use a non-emergency number to advise the emergency service 
dispatcher of your intentions. The dispatcher will give you further instructions on 
how to actually test the emergency number.

• This equipment may not be used on coin service or party lines.

• This telephone provides magnetic coupling to hearing aids.
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 NOTE
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A
AC power 1.10
ADF, load 3.4
alignment, cartridges 6.15
automatic dial 5.20

B
black copy 1.5, 3.7
black fax 1.6, 5.7
booklet, print 2.11
broadcasting 5.28

C
caller ID 5.40, 5.45
cancel

copy 3.8
fax 5.7
print 2.7
scan 4.5
scheduled fax 5.38

cartridge
align 6.15
clean 6.3
install 1.13
maintain 6.2
replace 6.9
type 6.10

cartridge holder
clean 6.8
location 1.3

character, enter 1.37
clean

cartridge 6.3
cartridge contacts 6.8
nozzle 6.6

clock mode 1.35
clone, special copy 3.12
collate, copy 3.10
colour copy 1.5, 3.7
colour fax 5.7, 5.17

copy
contrast 3.9
page 3.9
quality 3.8
size 3.10
special option 3.11

D
date and time, set 1.33
date format, change 1.35
default setting

copy 3.15
fax 5.6

delayed fax 5.30
dial mode, set 1.42
document

jam, clear 7.2
load in ADF 3.4
load on the document glass 3.5
type setting from PC 2.10

document glass
clean 6.20
load, document 3.5

DRPD
receive fax 5.17
setup 5.44

E
envelope, load 2.4
error message 7.7

F
fax

forward 5.18
option 5.41
receive 5.13
send 5.2

fax gate, configure 1.24
fit to page, special copy 3.12
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G
group dial 5.24

H
handout, print 2.13

I
ink level, view

from control program 2.18
from operation panel 6.3

ink save 1.43
install

cartridges 1.13
software 1.18
system requirement 1.19

internet gate, configure 1.24

J
jam, clear 7.4
junk fax 5.46

K
key sound, set 1.41

L
language, change 1.39

M
memory, clear 6.18
MFP driver

install 1.20
uninstall 1.28

mirror, special copy 3.14

N
nozzle, clean 6.6

O
one-touch dial 5.20
operation panel 1.5
orientation, print 2.10

P
paper

guideline 2.2
jam 7.4
load 1.11

paper save 1.43
paper size

set for copy 3.2
set for fax 5.42
set for PC print 2.10

paper type
select 2.2
set for copy 3.3
set for PC print 2.10

parallel, connection 1.9
pause 1.38
photo cartridge 6.9
PIN 3.16
polling 5.34
poster

copy 3.13
print 2.12

power save 1.44
print cartridge

align 6.15
clean 6.3
install 1.13
maintain 6.2
replace 6.9
type 6.10

print driver
install 1.20
remove 1.28

print quality 2.10
print setting

access 2.8
properties 2.9

printer control program 2.17
priority fax 5.32

Q
quality

copy 3.8
fax 5.4
print 2.10
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R
receive mode, fax 5.13
redial

count 5.43
interval 5.43

remote test 6.19
reports, print 5.39
resolution

fax 5.4
print 2.10

reverse page order 2.10
ringer volume 1.41

S
save

ink 1.43
paper 1.43
power 1.44

scan driver
install 1.20
remove 1.28

scan monitor 4.2
search memory 5.26
SmarThru

install 1.20

uninstall 1.28
speaker volume 1.41
special paper, load 2.4
speed dial 5.22
system data, set 5.41

T
toll save fax 5.11
TWAIN, scan 4.6
two-sided print 2.13

U
uninstall 1.28
USB

connect 1.9
mode change 7.14

W
web smoothing 2.10

Z
zoom rate 3.10
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